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Preface

How to Use This Book
This manual provides complete information for operating the Express Modem.
It is assumed that you are familiar with basic Macintosh desktop operations. If
not, refer to the manuals that come with your Macintosh.
m Chapter 1 explains how fax/modems work and describes the installation of
the Express Modem software.
m Chapter 2 covers the use of the Express Modem for data communications.
If you have never used a modem, you should read this part to familiarize
yourself with modem operation. Use this chapter as a complement to
communications software packages you may own.
m Chapters 3 through 6 cover the use of the Express Fax software for
sending and receiving faxes with your Macintosh. These chapters provide
complete information on the easy-to-use Express Fax program.

In the back
m At the back of the book you’ll find appendixes, a glossary, and an index.
The appendixes include information on the modem technical
specifications, the AT command set, and modem tips and troubleshooting.

ix

Communications regulation information
The following information is provided in compliance with US FCC (Federal Communications
Commission), Canadian DOC (Department of Communications).

Important
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected.

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception.
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation.
You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.
If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:
m Turn the television or radio antenna until the interference stops.
m Move the computer to one side or the other of the television or radio.
m Move the computer farther away from the television or radio.
m Plug the computer into an outlet that is on a different circuit from the television or radio.
(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)
If necessary, consult the service and support information that came with your computer for
instructions on how to contact an Apple-authorized service provider or Apple for assistance. Or,
contact an experienced radio/television technician for additional suggestions. You may find the
following booklet helpful: Interference Handbook (stock number 004-000-00345-4). This
booklet, prepared by the Federal Communications Commission, is available from the U.S.
Government Printing Office, Washington, DC 20402.

Important
Changes or modifications to this product not authorized by Apple Computer, Inc., could void
the FCC Certification and negate your authority to operate the product.
This product was tested for FCC compliance under conditions that included the use of shielded
cables and connectors between system components. It is important that you use shielded cables
and connectors to reduce the possibility of causing interference to radios, television sets, and
other electronic devices. For Apple peripheral devices, you can obtain the proper shielded
cables through an Apple-authorized dealer. For non-Apple peripheral devices, contact the
manufacturer or dealer for assistance.

x
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DOC Class B Compliance This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus set out in the radio interference regulations of the
Canadian Department of Communications.
Observation des normes—Classe B Le présent appareil numérique n’émet pas de bruits
radioélectriques dépassant les limites applicables aux appareils numériques de la Classe B
prescrites dans les règlements sur le brouillage radioélectrique édictés par le Ministère des
Communications du Canada.

Notify your local telephone company
Some telephone companies require that you notify the local business office when you hook up a
modem to their lines.

Information you need in the United States
A label on the modem contains, among other information, the FCC registration number and
ringer equivalence number (REN). If requested, provide this information to your telephone
company.
m FCC ID number Part 15: BCGM7784
This number confirms that your modem has been approved by the FCC.
m FCC registration number Part 68
This number appears on your Macintosh.
m Ringer equivalence number: 0.7B
The ringer equivalence number (REN) is useful to determine the quantity of devices you
may connect to your telephone line and still have all of those devices ring when your number
is called. In most, but not all areas, the sum of RENs of all devices should not exceed
five (5). To be certain of the number of devices you may connect to your line, as determined
by the REN, you should call your telephone company to determine the maximum REN for
your calling area.
m Model number: M7784
m Manufacturer: Apple Computer, Inc.
m Telephone jack type: USOC, RJ-11
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Information you need in Canada
The Canadian Department of Communications (DOC) label identifies certified equipment. This
certification means that the equipment meets certain telecommunications network protective,
operational, and safety requirements. The Department does not guarantee the equipment will
operate to the user’s satisfaction.
Before installing this equipment, users should ensure that it is permissible to be connected to the
facilities of the local telecommunications company. The equipment must also be installed using
an acceptable method of connection. In some cases, the company’s inside wiring associated
with a single-line individual service may be extended by means of a certified connector
assembly (telephone extension cord). The customer should be aware that compliance with the
above conditions may not prevent degradation of service in some situations.
Repairs to certified equipment should be made by an authorized Canadian maintenance facility
designated by the supplier. Any repairs or alterations made by the user to this equipment, or
equipment malfunctions, may give the telecommunications company cause to request the user to
disconnect the equipment.
Users should ensure for their own protection that the electrical ground connections of the power
utility, telephone lines, and internal metallic water pipe system, if present, are connected
together. This precaution may be particularly important in rural areas.

Warning
Users should not attempt to make such connections themselves, but should contact the
appropriate electric inspection authority or electrician.
m Load number: 5
The load number (LN) assigned to each terminal device denotes the percentage of the total
load to be connected to the telephone loop that is used by the device, to prevent overloading.
The termination on a loop may consist of any combination of devices and is subject only to
the requirement that the total of the load numbers of all devices does not exceed 100.
m Telephone jack type: CA-11

xii
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Telephone line problems
If your telephone doesn’t work, there may be a problem with your telephone line. Disconnect
the modem to see if the problem goes away. If it doesn’t, report the problem either to your local
telephone company or to your company’s telecommunications people.
Consult the service and support information that came with your computer for instructions on
how to contact an Apple-authorized service provider or Apple for assistance. The telephone
company may ask you to disconnect this equipment from the network until the problem has
been corrected or you are sure that the equipment is not malfunctioning.
If your modem causes harm to the telephone network, the telephone company may discontinue
your service temporarily. If possible, they will notify you in advance. But if advance notice isn’t
practical, you will be notified as soon as possible. You will be advised of your right to file a
complaint with the FCC.
Your telephone company may make changes in its facilities, equipment, operations, or
procedures that could affect the proper operation of your equipment. If the telephone company
makes such changes, you will be given advance notice so as to give you an opportunity to
maintain uninterrupted service.

Important
The modem will not work with party lines, cannot be connected to a coin-operated telephone,
and may not work with a digital private exchange (PBX).
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Introducing the Express Modem

In this chapter
This chapter informs you about
m Your modem package
m Other materials
m Modem design
m Express Modem capabilities and features
m Express Fax capabilities and features
m Connecting your Macintosh
m Installing the Express Modem software

Before you begin
Before connecting your Macintosh to your telephone line,
be sure you have everything you need.

1

Your modem package
The Express Modem package contains:
m the Express Fax/Modem User’s Guide
m a length of telephone cord
m a disk containing the modem and fax software
m depending on your CPU model, a country Data Access Arrangement (not
pictured here)
If you’re missing something, see the service and support materials that came
with your computer for a number to call.
The contents of your package are shown below.

Telephone cord

Express Fax/Modem
User’s Guide

Express Modem
Install disk

Note: Your telephone cord may look different from the one pictured.
Telephone connectors vary by region. Your package contains the telephone
cord appropriate for your region.

2
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Other materials
To use your Express Modem, you may also need:
m A modular connector on your telephone line If your telephone cord
cannot be removed from the wall or has a non-standard jack, you’ll need a
modular adapter or a new telephone system that provides a modular jack.
Ask your local telephone retailer for assistance in selecting the most
appropriate solution for a modular jack.
m An analog telephone line The Express Modem is designed for use with a
traditional telephone system (also called an analog system). Most homes
use an analog system.
m Communications Toolbox compatible software The Express Modem
comes with CTB compatible fax software. If you plan to use a terminal
emulator or other data communications package, you must purchase it
separately. It should be CTB compatible.
m PowerBook options Depending on the PowerBook model you have, you
can purchase an approved travel adapter for correct modem configuration
in the country you’re visiting. Ask your Apple dealer for details.

Other software you can purchase
In addition to the Express Modem and Express Fax software, you can
purchase communications software, such as MacTerminal, that fits your own
needs. A few types of software are discussed below.
AppleTalk Remote Access
AppleTalk Remote Access software allows you to connect to your office
AppleTalk network over telephone lines. With AppleTalk Remote Access you
can work anywhere there is a phone line, transferring files and accessing
electronic mail, printers, servers, and other network devices. The high speed
of the modem (up to 14400 bps) makes the connection time shorter and
therefore less expensive. See “Setting up AppleTalk Remote Access” in
Appendix C.
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On-line services
On-line services offer connection to data bases, bulletin boards, and a variety
of other services. Access software is provided at subscription time.
General communications applications
General communications applications allow simple terminal emulation, file
transfer, and remote connection. This type of software gives you the broadest
range of options, and allows you to take full control of your modem if you
decide to use the direct modem AT commands described in Appendix B.
If you want to use your modem for purposes beyond on-line services
for example to send a file from your computer to a friend’s computer, you
should acquire software compatible with the Macintosh Communications
Toolbox, such as MacTerminal. However, the Express Modem supports most
non-CTB compatible applications.
Some of the information in this guide may not apply to your particular
communications software. For in-depth information, see the user’s guide that
comes with the communications software you purchase.
. See also: Appendix A, “Communications Toolbox compatibility.”

Modem design
Communications capabilities are built into your modem, but you can’t use
them without installing the Express Modem and Fax software.
Once installed, the modem software and hardware work together as a team.
Many of the modem’s traditional functions, such as data compression, are
handled by the software.
With most commercially available modems, if you want to take advantage of
improved technology, you must buy new hardware. The advantage of having a
software modem is that you can easily upgrade your modem just as you
upgrade any other software. As such, you can obtain the latest improvements
by upgrading your software from a disk or server.

4
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Express Modem software
The Express Modem software consists of:
m Express Modem, a control panel, available from the Apple Menu, for
turning the modem application on and off, controlling the modem, and
monitoring modem status
m Express Modem Tool, a tool compatible with the Macintosh
Communications Toolbox for setting up and using your modem

Express Modem features
Here is a summary of Express Modem features:
m Hayes compatible
m High-speed data transfer at up to 14400 bits per second (bps)
m Error control for data integrity and reliability; data compression for
increased data throughput (up to 4 to 1)
m Simple interface that automatically allows the modem to make the best
connection without bothersome setup
m Easy upgrades and feature enhancement at lower cost
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Express Fax software
The Express Fax software consists of five programs to handle fax functions:
m Fax Terminal, a program for monitoring faxes during send and receive,
available from the Apple menu
m Fax Viewer, a program for viewing faxes you have sent or received
m Fax Sender, a printer driver for sending faxes and managing addresses
m Fax Extension, a system extension for managing send and receive between
the fax software and the modem
m Fax Cover, a program for making fax cover pages

Express Fax features
The Express Fax software supports Group 3 fax send and receive capability.
Express Fax allows you to convert any Macintosh program document to fax
format and send it to another computer capable of receiving faxes or to a
dedicated fax machine. Express Fax allows you to receive a fax from a Group
3 remote fax device.
Here is a summary of Express Fax features:
m Easy send and forward of fax documents by printing to a remote fax device
m Fax receive
m V.17, V.29, and V.27 ter CCITT high-speed, reliable fax send and receive
(14400, 12000, 9600, 7200, 4800, 2400) for Group 3 fax
m Shortcut selection of Fax Sender
m Viewing, printing, forwarding, and copying of faxes
m Fast imaging
m Fax Quick Send
m Telephone credit card support
m Fax smoothing feature that dramatically improves fax display
m Personalized fax cover page design

6
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Express Fax structure
The Express Fax programs handle assembly, transmission, and reception of
faxes. The following diagram shows how the programs interrelate.

Prepare a document
in your application.
Press Shift-Control
keys while choosing
Fax from File Menu

Fax Cover

Run this
application
to manage
cover pages

Attach
cover

Fax Sender
Appears in
place of Print
dialog box

Save

Fax Viewer

Forward

Run this
application to
view sent and
received faxes

Send Forward

Fax Terminal
Opens
automatically
when you send
or receive a fax

Print

View

Fax Extension
Manages send
and receive
between Fax
Terminal and
Express Modem
Express Modem

I

N T R O D U C I N G

T H E

E

X P R E S S

M

O D E M

7

Connecting your Macintosh
To link your Macintosh to your telephone line, connect one end of the
telephone cord to your Macintosh and the other to your telephone line.
1

Make sure that your computer is turned off.

2

Locate the internal modem on the back of your computer (RJ-11 receptacle).

3

Plug one end of the cord into your computer’s internal modem jack receptacle.
Internal Modem port icon

Internal Modem port
jack receptacle

Modem connector (RJ-11)

Note: The Internal Modem port in your CPU may be different than the port
pictured above.
4

Plug the other end of the cord into your telephone wall jack.

If a telephone is plugged into the jack you want to use, unplug your telephone
cord from the jack.
Note: Before attempting to use your modem over the telephone lines, make
sure the modem is properly connected.

8
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Installing the Express Modem software
The Installer places items in your System Folder and Extensions folder. Some
of these items are control panels and programs that you will use to send and
receive data and fax.
Note: If you are reinstalling or upgrading the modem and fax software, the
installer will not overwrite any existing fax phone book or cover pages.
. See also: Chapter 2, “Using Your Modem,” and refer to the user’s guide that
came with your communications software. To send and receive faxes, see
Chapter 3, “Express Fax Quick Start.”
1

Turn your computer on, and wait until the desktop appears.

2

Insert the Express Modem disk in your disk drive and, if necessary, double-click the disk
icon to open the Install window.

The Express Modem window opens.
3

To open the Installer, double-click the Installer icon.
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The Easy Install dialog box appears. Easy Install automatically detects the
Macintosh model you are using and installs the software correctly.

4

Make sure that the hard disk indicated in the box is where you want to install the
software.

If the wrong disk name appears, click the Switch Disk button until the correct
disk name appears.
5

Click Install.

A message informs you when the installation has been successfully
completed.
6

Click Restart to restart your computer and activate the software.

. See also: Appendix A for information on using the Express Modem
control panel.

10
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2

Using Your Modem

In this chapter
This chapter informs you about
m What modems do
m Reaching another modem

Before you begin
If you have followed the installation steps in Chapter 1, you are ready to
connect to another modem.

11

What modems do
Before two computers can exchange data via a modem connection, they must
be able to recognize each other and agree on how data will be transmitted.
Without modems, computers cannot exchange data over long distances
because the signal will degrade after a few meters. Therefore, to pass across
the PSTN (Public Switched Telephone Network), digital information from
your computer is converted to a sound modulated signal. The signal is
reconverted to digital by the receiving modem.
Modems also dial and establish connections between computers. They control
the flow of data across the telephone line so transmission takes place with
optimal speed and accuracy.

Setting up a connection
When two computers connect through their modems, the modems’ first task is
to reach agreement on speed, error control, and data compression. Reaching
agreement is called handshaking.
Handshaking is equivalent to saying, “I’m German; you’re French, but we
both speak English. So let’s speak English a little slowly. If we’re both
English, we can speak more quickly.”
Your modem is already set to automatically make the best possible
handshaking agreement. See Appendixes A and B for a complete list of
specifications and default settings.
In general, it is best to accept your modem’s automatic settings. If you want to
set your own speed, error control method, and data compression type, see the
user’s guide that came with your communications software and the AT
command set in Appendix B.

12
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Determining the speed
Initially, your modem tries to connect at 14400 bps, its fastest speed. If the
remote modem can’t connect at 14400 bps, your modem falls back to the next
highest speed. Fallback continues until the two modems agree on their
capabilities.

Error control
Error control is used by modems to check data for errors. Your modem and
the remote modem must agree on an error control method. Your modem will
try to use a method called V.42 and MNP class 2–4. If the remote modem
doesn’t support this type of error control, both fall back until an agreement is
reached.

Data compression
Data compression increases the speed of your modem by eliminating gaps
and redundancies from the data. For instance, if you connect at 14400 bps
with data compression enabled, the speed can increase up to 4 times the
non-compression speed.
Your modem uses a type of data compression called V.42 bis or MNP class 5. If
the remote modem doesn’t support these types of data compression, it will
not use any.
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Reaching another modem
The following example uses MacTerminal, CTB compatible communications
program. To use your communications software, you must select the modem
connection tool that corresponds to your modem, in this case the Express
Modem Tool. Most communications programs are similar, so you can
probably use this example with your own software.
1

Double-click the Sound control panel icon in the Control Panels window.

The Sound control panel appears.

. See also: “Express Modem control panel” for additional speaker and
other settings and “Communications Toolbox Compatibility” for using
non-Communications Toolbox applications in Appendix A.
2

If necessary, set the speaker volume above the lowest mark in the Sound control panel
then close the control panel.

Increasing the speaker volume allows you to listen as the modem dials the
telephone number you specify.

14

C

H A P T E R

T

W O

3

Open the Express Modem control panel and verify that Express Modem is turned on.

Note: Refer to Appendix A for Express Modem control panel settings
information.
4

Turn to the user’s guide that came with your communications software.

Your software’s user’s guide should explain how to choose the type of
connection you want and how to connect to another modem. Most
communications software programs have menus named Settings and Sessions,
where you will find the options you need. Check in the user’s guide for the
exact names.
If you have an on-line service, try dialing the service using the instructions
found in the user’s guide. If you want to connect to an on-line service, you
may have to match the service’s connection settings. Check the manual or
telephone the company that provides the service. (To match your service’s
settings, refer to Step 6 in this procedure.)
5

Open your communications software.
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6

Choose Connection from the Settings menu and select Express Modem Tool in the
Connection Settings pop-up menu.
Express Modem Tool should
appear in this pop-up menu.

This selection matches the Connections Method, the Express Modem Tool, to
your Express Modem.
You can now modify the Express Modem settings choices.

To make optimal
connection, select
Best Available. To
connect without
error correction or
data compression,
select None.

16
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Match these settings
to the remote modem’s
when connected.
Works when any of the
above Data Features
is selected.

7

Click Dial Phone Number under Modem Settings, enter the phone number of a
remote modem in the box below it, then click OK.

8

If you decide not to use Express Modem Tool, select another tool from the Connection
Settings pop-up menu.

For example, you can select Apple Modem Tool, Serial Tool, or another tool.
9

Double-click the Internal Modem icon in the Current Port field.
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10

Choose Open Connection from the Session menu.

Selecting Open Connection is the same as lifting up the receiver of your
telephone. Depending on the software application you’re using, you should
be able to hear the modem dialing the telephone number for you if you have
entered a phone number. If you can hear a dial tone and the modem dialing
the telephone number or a busy signal, you’re properly connected to the
telephone line.

18
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11

Select Express Status in the Express Modem control panel.

The Express Status field appears in the Express Modem control panel. This
field monitors the connection process, providing you with information on
connection speed, error and compression protocols, and status messages.

. See also: “Express Status” in Appendix A for additional information on this
subject.
12

When you want to terminate the connection, choose Close Connection from the Session
menu.

If you connect to a service, you may have to log out and use the “hang up”
command. Refer to your communications software or service software
manual.
Note: Before attempting to use your modem over the telephone lines, make
sure you understand how to dial a number and hang up.
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3

Express Fax Quick Start

In this chapter
m Using Fax Quick Send
m Receiving and printing a fax

Before you begin
If you have skipped directly to this chapter, please make sure that you have
connected your modem to the telephone line, verified your connections, and
installed the Express Fax software. See Chapter 1 for software installation.

21

Using Fax Quick Send
You can start by sending an easy first fax with Fax Quick Send. Use this first
fax exercise as a tutorial, then explore more advanced features in Chapter 4,
“Getting the Most Out of Your Express Fax.”
1

Open the Express Fax Folder, then open “My first fax” by double-clicking it.

You can make a fax of a document from any program or any window on the
desktop. The TeachText document “My first fax” has been provided for your
convenience.
2
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Hold down the Control and Shift keys while choosing Fax from the File menu.

H R E E

The Fax Sender dialog box appears in place of the Print dialog.

Sending a fax is like printing to a remote printer.
IMPORTANT Step 2 is a shortcut. You can also select Fax Sender in the

Chooser (see Chapter 4, “Selecting Fax Sender”). This shortcut works with
all programs, but some applications’ menus may not change Print to Fax. If
the menu doesn’t change, choose Print from the File menu.
3

In the Fax Quick Send field, type the fax number of your recipient.
Put the recipient’s fax number in
the Fax Quick Send box.

If you use a number to obtain an outside line from your
present location, place it in the Dial Prefix box.
Insert a comma after the number to indicate a pause.
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4

Click the Options button.

The Options dialog box appears. Make sure you select Tone or Pulse
according to the type of phone you have.

5

To save the information you entered, click OK.

You return to the Fax Sender dialog box.
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6

To fill in sender information, click the Cover Info button.

Type information about yourself in the Cover Info dialog box. To move from
field to field, use the Tab key. The information you type here will appear on
your fax cover page.
The Station ID can be any combination of letters and
numbers you wish to identify your fax with.

Type any special messages in the Notes field.
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7

To save the information you entered, click OK.

The Fax Sender dialog box reappears.
8

To see your first fax before sending, click the Preview button.

Preview displays the fax with the cover page. The cover page selected is the
Standard cover page. The sender information you entered in the Cover Info
dialog box is displayed during preview. Click the right arrow in the scroll bar
at the bottom of the Preview dialog box to view the other pages of your fax.
9

Click Send to transmit your fax.

Your fax is transmitted immediately.

26

C

H A P T E R

T

H R E E

10

To monitor the sending of your fax, choose Fax Terminal from the Application menu at
the right end of the menu bar.
Application menu icon

Fax Terminal appears in
the Application menu shortly
after you click Send.

Fax Terminal appears.

The status window
displays a series of
messages during
transmission.

Should transmission fail on the first attempt, Fax Sender automatically
retransmits your fax twice. (You can change the number of retries in Fax
Terminal Preferences; see “Setting Preferences” in Chapter 4.)
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11

Choose Fax Log in the Fax Terminal Windows menu.

Once the fax is sent, you can check transmission results in the Fax Log. You
have sent your first fax, and, equally important, you have verified that
transmission was successful.

If Fax Terminal will not open
Fax Terminal will open in the background only if sufficient memory is
available.
m If you are expecting a fax, be sure to quit any unnecessary applications to
free up memory. You may want to acquire more RAM memory for your
Macintosh; see your Apple dealer.
m If Fax Terminal does not open, it may also be a result of the Fax Terminal
Preferences selected. See “Setting Preferences” in Chapter 4. Even if Fax
Terminal doesn’t open during reception, fax reception will occur without
problem. You won’t lose any faxes.
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Receiving your first fax
Your Express Fax receives faxes just like an office fax machine. You can be
working on your computer or away from home or office when a fax arrives.
By default, the fax software is not set to receive faxes when it is installed. The
Auto-Answer checkbox in the Fax Terminal Preferences dialog box must be
selected.
To receive a fax in your absence, you must leave your Macintosh turned on,
but none of the fax programs need be open.

Getting ready to receive faxes
1

Choose FaxTerminal from the Apple menu.

Fax Terminal opens.
2

Choose Auto-Answer from the Fax menu.

This choice automatically sets the Auto-Answer checkbox in Fax Terminal
Preferences.
. See also: “Setting Preferences” in Chapter 4 and “Auto-Answer” and “Call
management” in Appendix A.
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Checking for received faxes
1

Look for the Fax Terminal icon blinking over the Application menu on the menu bar.

The Application menu is at the right side of the menu bar.

The blinking icon tells you that a fax is waiting in the Fax Terminal Received
Fax folder.
2

Choose Fax Terminal from the Application menu or the Apple Menu.

Fax Terminal appears.
3

To select the received fax you wish to view, click its name in the Fax Terminal queue,
then click Open.

You can also manage fax reception yourself.
. See also: “Receiving Manually” in Chapter 4.
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Opening a document in the Fax Terminal queue automatically opens Fax
Viewer, and your fax appears in a Fax Viewer window.

4

To set up your fax for printing, choose Page Setup, then choose Print from the
File menu.

You can use Fax Viewer to prepare your fax for printing, forwarding, or
saving.
. See also: Chapter 5, “Fax Viewer,” for a complete reference of the Fax
Viewer features.
Most of the time, you will want to print only incoming faxes. Fax Viewer
handles printing in the same way any other Macintosh application does.
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4

Getting the Most Out of Your Express Fax

In this chapter
m Setting up your fax environment
m Using Fax Sender
m Monitoring incoming and outgoing faxes
m Receiving and opening a fax

Before you begin
Review the material in Chapter 3 to make sure you understand the basic
steps of fax operation.
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Setting up the fax environment
You can begin by setting up Fax Terminal to take advantage of all features.

Entering fax station information
This information provides your return address, allowing the recipient to
identify you from the received cover page.You can enter cover information
both in the Fax Sender Fax Cover Info and Fax Terminal Info dialog boxes.
1

Open Fax Terminal.

2

Choose Fax Terminal Info from the Fax menu.

A Fax Terminal Info dialog box appears.
3

Type information in the various fields of the dialog box.

Station ID is a 20-character header line identification of
your choice. If your recipient’s fax device has the
capability, Station ID is printed on the top of each page of
the fax document, along with the date and time.

4
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Click OK to save the Fax Terminal information.

Setting Preferences
The Preferences dialog box allows you to control Fax settings.
1

Choose Preferences from the Fax Terminal Fax menu.

The Preferences dialog box appears.
Check this box to activate Fax
Terminal while a fax is being
sent or received.

Sets auto-answer and number of rings.
You can always answer manually. See
“Receiving Manually” later in this chapter.

Select this box to save
fax files. Check Fax
Terminal fax folders
from time to time for
available disk space.

Displays notification for received faxes, manual dial, and errors.
A batch of faxes may be interrupted by one unsuccessful fax.
Selecting None allows a batch of faxes to be sent without
interruption. Unsuccessful faxes can be resent.

2

Click the options to make your choices.

Table 4-1 summarizes the choices available.
Note: If you select None in the Preferences dialog box, Fax Terminal does
not interrupt sending a batch of faxes should a single fax fail for any reason.
3

To save your Preferences, click OK.
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WARNING Certain fax image files may use large amounts of disk space.

If you frequently receive large files, be sure that you have enough space
on your hard disk.

Table 4-1 Fax Terminal Preferences dialog options
Preference fields

Result

Show Fax Terminal
window

Allows Fax Terminal window to be displayed automatically during
send and receive. If not selected, you can still activate it during send
or receive.

Save fax image files

Faxes are transmitted and received as image files. This checkbox
allows you to save sent fax image files.

Turn off V.17

If the remote fax does not support V.17, you may have to turn it off.

Turn off ECM

If the remote fax does not support ECM, you may have to turn it off.

Auto-Answer
(unchecked by default)

Must be checked to receive faxes automatically. If unchecked, you
may still receive manually. Review procedures in “Receiving a fax”
in this chapter. Can be set in Fax menu.

When sending fails
Retry

Sets the number of retries.

Time between tries

Sets the time between tries.

Resend all pages

Resends the entire fax if transmission fails.

Resend only those
pages not already sent

Sends only the pages that failed to transmit.

Received Fax, Manual Dial,
Error Notification
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None

No notification. Check the log for received faxes or failures. Check Fax
Terminal for received faxes.

Display icon

Displays icon in menu bar so that you can check for received faxes and
transmission problems.

Display icon and alert

Displays icon in menu bar so that you can check for received faxes and
transmission problems. Displays alert box for Manual Dial and Errors.

Using Fax Sender
Fax Sender handles all aspects of fax transmission including forwarding.

Selecting Fax Sender
Selecting Fax Sender is like selecting a local or network printer, such as an
ImageWriter or a LaserWriter.
1

Choose the Chooser from the Apple menu (K).

The Chooser window appears.
2

Scroll down the icons in the upper-left box, if necessary, until you see the Fax
Sender icon.

3

Click the Fax Sender icon.

The modem icon appears in the box on the right side of the window.

4

Close the Chooser by clicking the close box.

As long as Fax Sender remains selected, all print jobs go to the fax process,
not to your printer. Be sure to reselect the printer icon in the Chooser when
you have finished sending your fax.
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IMPORTANT As an alternative to the above method of selecting Fax Sender,

hold down the Control and Shift keys while choosing Fax from the File menu.
This shortcut does not deselect your regular printer; you return automatically
to your previous printer settings for printing after the fax is sent. This
shortcut works with all programs, but some applications’ menus may not
change Print to Fax. If the menu doesn’t change, choose Print from the
File menu.

Fax Sender Page Setup
A number of options are available in the Fax Setup dialog box.
1

Choose Fax Setup from the File menu.

Be sure that you have selected Fax Sender in the Chooser. Otherwise, use the
shortcut of holding down the Control and Shift keys when you select Fax
Setup from the File menu. Note that the File menu items Print and Page
Setup automatically change to Fax and Fax Setup respectively.

2

Select Fax Setup options as needed, and then click OK.

Refer to Table 4-2 for option settings.
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Table 4-2 Fax Sender Page Setup options
Option

Result

Orientation
Portrait

Transmits the fax vertically.

Landscape

Transmits the fax horizontally.

Reduce or Enlarge

Reduces or enlarges the fax by the percentage you indicate.

Image Quality
Fine

Converts fax to highest image quality for sending. Increases the send time.

Standard

Converts fax to normal image quality for sending. Decreases the send time.

Bitmap Alignment

Scales the Macintosh 72 dpi image so that every pixel is matched evenly
to the fax machine resolution. Produces the best-quality image for
bitmapped documents, but enlarges the printed image to 108% of
actual size.

Entering cover page information
The Cover Page Information dialog box is similar to the Fax Terminal Info
dialog box. Both dialog boxes provide space for entering return address
information to help your correspondent identify you. In addition, the Cover
Page Information dialog box provides space for the document subject and a
short note.
1

Choose Fax from the File menu.

The Fax Sender dialog box appears instead of the usual Print dialog box.
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2

To fill in cover page information, click the Cover Info button in the Fax Sender
dialog box.

The Cover Page Information dialog box appears.
3

Type information you want to appear on the cover page of the fax you are sending.
The sender name you see when you first open the
dialog box is the Owner Name you entered for
AppleShare in the Sharing Setup control panel.

If you have already entered your return address information in Fax Terminal,
you can change the information, the document name, or add a note. When
you change the information in the Cover Page Information dialog box, it
changes the information entered in the Fax Terminal Info dialog box, and vice
versa.
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Using a telephone credit card
The Telephone Credit Card option allows you to use a credit card or calling
card to send a fax.
Note: Until the dial card number is changed or deselected, all sent or
forwarded faxes use this number. Be careful to remove the number for calls
not dialed by credit card.
1

Type the credit card access code in the Fax Sender Dial Prefix box.

2

Click Options in the Fax Sender dialog box.

The Options dialog box appears.
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3

To charge a fax to your credit card account, click the Telephone Credit Card checkbox,
then enter your credit card number.

Many phone systems send a tone to indicate when the calling card number
and PIN should be entered.

To detect the tone, enter a colon (:) in front of the
credit card number. If you find that the tone is not
being properly detected, enter one or more commas
to pause before sending the calling card number.

4

To continue setting up your fax, click OK.

Fax Sender protects your privacy by hiding your credit card number when the
Options dialog box is reopened.
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Using dial modifiers
Placing a comma in any position in the telephone number, Dial Prefix box, or
Dial Card Number field requests a two-second pause. This may be useful
when dialing long distance or overseas. To increase the pause time, add more
commas.
You may need to put additional dial modifiers after the dial prefix or before
the credit card number if your long distance service acknowledges an access
code or telephone number with a tone before placing the call. See the Dial
command in Appendix B.
Dial Modifier

Result

Comma (,)

Introduces a two-second pause before sending the next character.

“At sign” (@)

Detects a specified period of silence before completing dial string.

Dial tone detect (W)

Detects presence of dial tone before completing dial string.

Colon (:)

Same as W. Detects a wider range of tones, such as Calling Card tones,
before finishing dial string.

Selecting a cover page
The fax software comes with three cover page choices:
m Standard is a precomposed text-only cover page. You can use it as is or
modify it with the Fax Cover program. Standard appears in the Fax Sender
Cover Page pop-up menu as the default selection. (Standard can be deleted
as a cover page choice.) . See also: “Installing cover pages” in Chapter 6.
m None means that no cover page is attached to the fax. The first page of the
document can be used as a cover page.
m A sample cover page comes with the fax software in the Express Fax
Folder. This choice does not appear in the Fax Sender Cover Page pop-up
menu unless installed with Fax Cover. . See also: “Installing cover pages”
in Chapter 6.
You can create as many customized cover pages as you need.
. See also: “Customizing cover pages” in Chapter 6 to compose and modify
customized cover pages.
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1

Select a cover page from the Fax Sender Cover Page pop-up menu.

XYZ Cover is a customized
cover page.

Automatic dialing
Auto Dial allows you to use the Fax Phone Book and delayed send features in
Fax Sender. For example, you can use Fax Phone Book to send a fax to
multiple recipients.
When you send the same fax to more than one person at a time and there is a
delivery problem for any recipient, Fax Sender puts the fax to that recipient in
the waiting queue for retry (according to the number of tries you selected in
the Retry field in the Fax Terminal Preferences dialog box). At the same time,
Fax Sender delivers the fax to the other recipients in the order placed in the
Send To field.
Auto Dial is the default selection in Fax Sender. When Auto Dial is selected,
you can transmit your fax from the Fax Sender or from the Preview dialog
box. Auto Dial applies to most cases. See “Manual Dialing” later in this
chapter.
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Using Fax Phone Book
Fax Phone Book holds a list of recipients along with their addresses and
telephone numbers. You can enter, update, and remove entries from the list
and then use the list to address your faxes by selecting recipients by name.
Adding addresses
You create a list of recipients one by one. You can add their addresses at send
time or whenever you wish.
1

Click New in the Fax Sender dialog box.

These are existing Fax
Phone Book entries.

G

This entry has been dragged into the Send To field for
sending. A dimmed entry remains in the Fax Phone Book.

E T T I N G

T H E

M

O S T

O

U T

O F

Y

O U R

E

X P R E S S

F

A X

45

A New Entry dialog box appears.
2

Enter the address information and click Add.

You must fill in the Last Name
and Fax # fields. The other
fields are optional.

Parentheses and dashes can
be included in the Fax # and
Voice # fields.

New names are added automatically to the Fax Phone Book when you
click Add.
Editing addresses
1

To edit an address:

m Select an address in Fax Phone Book and click Edit in the Fax Sender
dialog box, or
m Double-click an address in Fax Phone Book while holding down the
Option key.
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2

Change the information by selecting the text and retyping, and then click one of the
buttons when you are finished.

m Change saves your edits.
m Cancel restores the old address.
m Delete removes the address from the Fax Phone Book.

Removing addresses
To remove an address from Fax Phone Book, select the address, then:
m Press the Delete key on your keyboard (you are asked to confirm the
deletion), or
m Press x-X. (You must use the keyboard shortcut for the Cut command.)
To remove addresses from the Send To scroll box:
m Drag the address outside the scroll box, or
m Double-click the address.
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Addressing a fax
You can address a fax to one or more recipients. Fax Sender sends the fax to
each recipient, one at a time, in the order placed in the Send To field.
To address a fax:
m Double-click the address in Fax Phone Book, or
m Drag names from Fax Phone Book to the Send To field.

To obtain an outside line when dialing from office buildings, you may need to
place a number, such as a 9, before the telephone number. Put this number in
the Dial Prefix box. By placing the prefix number in the Dial Prefix box, you
can keep the numbers in Fax Phone Book independent of the dialing prefix.
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Setting send time
You can change the send time in the Fax Sender Options dialog for the
current fax and in Fax Terminal for any faxes in the queue.
Sending immediately
If the Send Immediately button is selected, your fax is sent immediately. Send
Immediately is the default.
Delaying send time (“Send at”)
Fax Sender allows you to choose the time you want to send a fax.
1

Click the “Send at” button in the Fax Sender Options dialog box.

The time displayed is the system time you set in the General Controls panel
or with the Alarm Clock.
2

Click any element in the time or date displays that you wish to change.

An arrow button appears and the element you are changing is highlighted.
3

Click a directional arrow to set the time.

Be sure not to set the time back before the current hour or date.

You can also change the send time while a fax is waiting to be sent.
. See also: “Resetting the send time” later in this chapter.
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Previewing a fax
Preview is similar to the “print preview” feature of some programs.
m If you wish to see your fax before sending, click Preview in the Fax Sender
dialog box.

Scrolling pages
Use the scroll bar at the bottom of the window to view each page. Clicking
the arrow at the right end of the scroll bar allows you to move through the fax
one page at a time beginning with the cover page.
Changing views
Clicking the View button toggles between a reduced and an actual size view
of a page. In actual size, you can move the page with the grabber hand to
examine an undisplayed portion of the page.
Note: If you click Cancel while in the Preview dialog box, you go back to
your document, not to the Fax Sender dialog box. Names that you have
dragged to the Send To scroll box are lost; you will have to select Fax
Sender again.
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Manual dialing
Most fax machines can be dialed automatically. Occasionally, you may have to
use your telephone to manually dial a recipient’s fax device. You might have to
do this if the line is shared by several devices, is an extension, or needs to be
set to receive.
IMPORTANT To use Manual Dial, your telephone must be connected to the

same telephone jack as your modem. You can purchase a Y adapter to make
this connection.
1

Choose Fax from the File menu.

2

Click the Manual Dial button.

3

Drag a recipient name from your Fax Phone Book to the Send To scroll box or type a
number in the Quick Send field.

4

Click Send.

After Fax Sender has prepared your Fax for sending, a blinking icon notifies
you that your fax can now be sent by dialing manually.
. See also: “Setting Preferences” earlier in this chapter.
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5

When you see the blinking icon at the right end of the menu bar, select Fax Terminal
from the Application menu.

The Manual Dial dialog box appears.

6

Follow the instructions in the Manual Dial dialog box.

m Dial your recipient’s fax device from your telephone.
m Click Send when you hear your recipient’s fax tone.
m Hang up the telephone.
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Table 4-3 Fax Sender options
Option

Result

Dial
Auto
Manual

Dials recipient’s fax number automatically.
Allows you to dial recipient’s fax number manually.

Dial Prefix

Adds PBX or other access code prefixes at send time. Use commas for
two-second pauses.

Cover page
Standard
None
Custom choices

Sends fax with text-only cover page.
Sends fax without cover page.
Sends fax with cover page designed in Fax Cover.

Fax Phone Book

To add an address, click New. To edit an address, click Edit. To remove
an address, select the address and use the Delete key on the keyboard.
You are asked to confirm.

Send to

Displays the recipient addresses for the current fax. To remove an
address, drag outside the box or double-click.

Preview

Allows you to preview your fax before sending.

Cover Info
Sender information
Subject
Notes

Allows you to enter your name, address, voice, and fax numbers.
Prints document name or name you choose on cover page.
Prints a short note in cover page Notes field.

Options
Dial
Tone
Pulse

Selects Touch-Tone dial.
Selects pulse dial.

Send time
Send immediately
Delay send (“Send at”)

Sends the fax immediately (default).
Allows you to choose the time to send the fax.

Telephone Credit Card
Dial Card Number

Allows you to automatically append your credit card calling number to the
telephone number. All faxes use this credit card number until changed.
Place dial modifiers before credit card number if necessary.

New

Allows you to create a new address and add it to Fax Phone Book.

Edit

Allows you to edit and delete addresses in your Fax Phone Book.
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Monitoring a fax
Fax Terminal allows you to forward faxes, check the status of faxes currently
being sent and received, review the list of sent and received faxes, cancel a
currently transmitting fax, delete faxes from any of the queue folders, and
reset the send time for faxes. You can also open and view the faxes in your
lists.
Fax Terminal contains a log for keeping track of fax results.
Shows recipient or sender
name for fax in progress.

Icons show status
of fax in progress.

Displays document file
name or name you
typed in Fax Sender
Cover Info Subject field.

An unopened fax inside
the Received Fax folder.

A downward pointing
triangle indicates that
the folder’s contents are
displayed.

A right pointing triangle
indicates that
the folders contents are
not displayed.
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An opened fax inside the
Received Fax folder.

The folders for Received, Sent, and
Waiting To Be Sent faxes in the Fax
Terminal queue. Double-click to
display contents.

Accessing Fax Terminal
Fax Terminal is a program that you will use frequently. For example, you may
wish to check Fax Log quickly. As initially installed, Fax Terminal is
accessible from the Apple menu (K).
While preparing your fax, Fax Terminal opens automatically and its name
appears in the Application menu at the right end of the menu bar. Whether
you view Fax Terminal automatically at send or receive time depends on the
selection you made in the Fax Terminal Preferences dialog box. To bring Fax
Terminal to the front:
m If you chose “Show Fax Terminal window when sending or receiving” in
the Preferences dialog box, choose Fax Terminal from the Application
menu.
m If you chose not to show the Fax Terminal window, select Fax Terminal
from the Application menu and then choose Fax Terminal from the
Windows menu.
. See also: “Setting Preferences” in this chapter.
Once transmission is complete, if the fax queue is empty, Fax Terminal closes
automatically when you change to another open program.
IMPORTANT If an alert message appears saying you don’t have enough

memory to open Fax Terminal at send time, you must quit some of your active
programs to provide enough memory for Fax Terminal to open. You won’t lose
any work, and your fax is still prepared. As soon as you quit the programs,
Fax Terminal opens and your fax is sent.
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Table 4-4 Fax Terminal document types
The Fax Terminal queue contains three types of folders: Received Fax
Documents, Sent Fax Documents, and Waiting To Be Sent Documents.
Icon

Document type

Received Fax Documents
Read
These documents have been received and read. They can be forwarded.
Unread
These documents have been received, but not opened. They can be opened and
forwarded. See “Opening a fax document” later in this chapter.
Sent Fax Documents
Successful
These documents have been successfully sent. They can be opened and forwarded.
Unsuccessful
These documents were not sent because of transmission problems. They can be opened
and forwarded. The preferences you selected for the original fax in Fax Terminal
preferences apply to forwarded unsuccessful faxes.
Waiting To Be Sent Documents
Send Immediately (Default)
If you send four faxes in rapid succession, one is sent while the three others
take a place in the queue. You can change the order of transmission in the queue by
dragging a Send Immediately fax up or down to a new position in the list.
Delayed Send (“Send at”)
A Delayed Send document’s send time is set in the Fax Sender Options dialog box.
You cannot drag a Delayed Send document to a new position in the queue. See “Resetting
the send time” later in this chapter to reset the send time.
Retry
A Retry is a fax that has returned to the queue after unsuccessful transmission.
A Retry takes its next send time from the “Time between tries” setting in the Fax Terminal
Preferences dialog box. You cannot reset the time of a Retry fax. A Retry becomes an
unsuccessful fax after the number of retries expires.
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Forwarding a fax
You may forward any fax you’ve sent or received.
1

Select a fax document in either the Received Fax or Sent Fax Documents folders.

2

Choose Forward Fax from the File menu.

The Fax Sender dialog box appears. The Send button changes to Forward.
3

Enter a fax number in the Quick Send field or select an address from the Fax Phone
Book.

. See also: “Addressing a fax” in this chapter.
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4

To forward your fax, click Forward.
You can limit the number of pages
to forward by entering a range of
page numbers.

m Received faxes are forwarded as received with the original cover page if
one was attached, and with your cover page if you select one.
m Sent faxes are forwarded without the original cover page, but you can
select and include one when you forward.
m To forward a fax without attaching your cover page, select None from the
Cover Page pop-up menu.

Resetting the send time
You can reset the send time of a delayed fax in Fax Terminal. You cannot drag
a delayed fax in front of another fax in the queue because you have already
assigned it a specific send date and time in the Fax Sender Options dialog
box, but you can change the assigned send time. See Table 4-4 “Fax Terminal
document types.”
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To reset the send time of a delayed fax, open the Waiting To Be Sent folder and select a
delayed fax by clicking its name.

2

Choose Set Send Time from the Fax menu.

O U R

3

To reset the send time, select the element of the date or time you want to change.

4

Click the arrow buttons in the Set Send Time box, then click OK.

In this example, the time of the second fax is set ahead so that it can be sent
before the first fax.
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Canceling a fax
Canceling a fax stops sending or receiving of the fax in progress.
1

Bring the Fax Terminal window to the front.

2

Choose Cancel Sending or Cancel Receiving from the Fax menu.
This menu item
changes to Cancel
Receiving, as the
case may be.

The current fax stops sending or receiving after a few seconds and Fax
Terminal becomes available again. Cancel Sending does not affect faxes in the
queue.
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Deleting faxes
You can delete faxes from the lists inside the folders in the Fax Terminal
queue. You can select several faxes discontinuously by opening the folders,
holding down the Shift key, and clicking faxes.
1

Open one or more folders.

2

Select one or more faxes to delete.

3

Click the Delete button or press the Backspace or Delete keys.
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Using the Fax Log
The Fax Log keeps information about fax transmissions. This information
may be useful to prove that a fax was actually sent or received at a given time.
The log is especially useful when you need to check the results of delayed
faxes.
Each fax, whether sent or received successfully or not, is automatically
recorded as an entry in the log. When transmission is finished, you can check
transmission results in the log.
m To see the log, choose Fax Log from the Windows menu.
The Fax Log appears and you can scroll up or down.

Managing log entries
For easy log management, you should limit the number of entries in the log,
then archive the log by saving the contents as an archive file with a new file
name. For example, you might name the archive files Faxes Jan, Faxes Feb,
and so on.
1

Choose Set Log Entries from the Fax menu and set the number of entries you wish.

The preset limit for the number of entries in the log is 50. To avoid losing
entries, save the log under a different name as you approach the limit.
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2

To save the log under a new name, choose Save Log As from the File menu.

3

Type the name you want for the file, then click Save.

O U R

Clearing the log
Once you’ve saved the log as an archive file, you can clear the old entries from
the log.
m To clear the log, choose Clear Log from the Fax menu.
This clears the entries in the log. Because you have saved the contents of the
log under another name and then cleared the log itself, no information is lost.
IMPORTANT It’s up to you to save the log under another name when you are

approaching the limit. If you reach the limit without saving, the oldest entries
are removed automatically so that the log never contains more than the
chosen number of entries.
To check historical information on the results of a given fax, you can display
any archived logs by opening them with TeachText or a word processor. You
cannot open the Fax Log with TeachText or a word processor.
Table 4-5 Fax Terminal Fax Log
Menu option

Result

File
Save Log As

Saves log under a different name. Archived logs can be opened by
TeachText.

Fax
Set Log Entries

Specifies the number of entries the log contains. Preset value is 50.

Clear Log
Clears entries in the log. (You should archive the log under a different
name before clearing.)
Window
Fax Log

Displays Fax Log. Log may be printed during display.
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Receiving a fax
Faxes can be received automatically or manually. The Fax Terminal
application doesn’t have to be open to receive a fax. Make sure your computer
is correctly set to receive.
. See also: “Auto-Answer” in “Express Settings” in Appendix A.

Setting Fax Terminal preferences for receiving
If you want to receive faxes automatically, you must set Fax Terminal
preferences or use the shortcut.
1

Choose Preferences from the Fax menu.

Choosing Auto-Answer is a shortcut for
clicking Auto-Answer in Fax Terminal
Preferences.

2

Click the “Auto-Answer” checkbox in the Preferences dialog box, set the number of
rings, then close the dialog box.

IMPORTANT If you deselect the Auto-Answer checkbox, faxes can only be

received manually.
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Checking for received faxes
Faxes are placed in the Received Fax Documents folder.
According to the choice made in the Fax Terminal Preferences dialog box,
Fax Terminal provides the following notification for received faxes.
Fax Terminal
Preferences choice

Fax Terminal notification

None

No notification. To see if you have received a fax, open Fax Terminal and
look for received fax documents in the queue or a blinking arrow in the
Status box. You can also check Fax Log.

Display icon

Fax Terminal displays a blinking icon in the menu bar when a fax is
received. See example below.

Display icon and alert

Fax Terminal displays a blinking icon in the menu bar when a fax is
received. See example below.

The following example assumes that Display icon is selected.
1

When you see the blinking icon, choose Fax Terminal from the Application menu.
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The Fax Terminal window appears.
2

Look for the blinking arrow above the icon in the Status box.

A blinking arrow tells
you when a fax has
been received.

Receiving a fax while you're working
If you set Show Fax Terminal Window in Fax Terminal Preferences and you are
working at your Macintosh, the Fax Terminal status field indicates the
progression of a fax received.
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Opening a fax document
When you open a fax document in Fax Terminal, the Fax Viewer program
automatically starts.
1

Click a fax document in the Sent Fax Documents or Received Fax Documents folders.

2

To view your fax document in Fax Viewer, click Open.

The Fax Viewer program opens and your document appears in a Fax Viewer
window.
. See also: “Viewing a fax” in Chapter 5.
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Receiving manually
Manual receive provides the option of sharing the same telephone line for fax
and voice calls. If you receive faxes occasionally, you can keep your line open
for voice calls and still receive faxes on the same line when you hear the
fax tone.
Manual receive is always enabled. Even if Auto-Answer is disabled, you can
always receive faxes manually.
1

Answer the telephone.

2

When your correspondent informs you he is ready to send you a fax or when you hear
the fax tone, choose Receive Manually from the Fax menu.

A Receive Fax dialog box appears.
3

When you hear the fax tone, click Receive.

When reception is complete, the fax appears in the Fax Terminal Received
Fax Documents folder.
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5

Fax Viewer

In this chapter
This chapter explains the Fax Viewer program features in the most likely
sequence of events for handling a received fax
m Opening a fax
m Viewing a fax
m Improving fax display
m Editing the pages of a fax or resequencing it
m Selecting part of a fax to paste into a document created by a
graphics program
m Printing a fax
m Converting a fax to PICT format
m Forwarding a fax

Before you begin
You should be familiar with the information in Chapters 3 and 4
on receiving faxes.
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Opening a fax
You can use several methods to open a sent or received fax for viewing in
Fax Viewer.
m Open a Fax Viewer document by one of the following methods:
M Double-click a document in the Sent or Received Fax Documents
folders in the Fax Terminal queue.
M Select a document from the Sent or Received Fax Documents folders in
the Fax Terminal queue, and then click Open.
M Open a Sent or Received Fax document in Fax Viewer using the Open
command in the File menu.
M Double-click a Fax Viewer document in the Finder.
Your fax document appears in a Fax Viewer window.
Fax Viewer menu bar

Paging
scroll bar
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Page icon

Page positioning
scroll bars

Viewing a fax
You can view a fax document at different resolutions by choosing options in
the Page menu:
m Actual Size displays your fax at the real page size (default).
m Fit in Window displays a full page of your fax on your screen.
m Fax Resolution View means that each dot of the 200 dots per inch (dpi)
fax is displayed as a pixel on the Macintosh screen. The resulting view is
approximately 277% of actual size.

Positioning a document
Your screen may be too small to display an entire page within the active
window.
m To examine undisplayed portions of a page, use the vertical and
horizontal page positioning scroll bars at the right of the Fax Viewer
window.

Scrolling pages
m To scroll pages, use the paging scroll bar at the lower left of the Fax
Viewer window.
Clicking the arrow at each end of the paging scroll bar
scrolls through the fax one page at a time.

To scroll to an approximate page, move the page
icon along the scroll bar. For example, to view page
5 in a 10-page document, move the page icon to the
center of the scroll bar.
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In addition to the paging scroll bar, the Page menu offers commands for
changing pages:
m Previous Page allows you to move backward one page.
m Next Page allows you to move forward one page.
m Go To Page displays a dialog box for moving to a specific page.

Changing the page orientation
You may want to change the orientation of a page if a fax you received is
turned the wrong way, for example upside down.
m Choose the orientation you wish from the Page menu.
M

Rotate Right turns the current fax page 90 degrees clockwise.

M

Rotate Left turns the current fax page 90 degrees counterclockwise.

M

Flip Vertical rotates the current fax page 180 degrees.

M

Flip All Pages rotates all the pages in the current fax 180 degrees.

Improving fax display
Fax Viewer has a special smoothing feature that allows you to optimize fax
display. Smoothing increases the sharpness of a fax on your screen,
permitting easier reading and scanning with OCR software.
1
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Set your monitor to Color or 256 Grays in the Monitors control panel.

Depending on the content of the received fax, you can experiment with the
monitor settings and the Use Smoothing command to get the best resolution
for display. Smoothing is enabled by default.
2

Choose Use Smoothing from the Page menu.

How smoothing works
The resolution of a fax is 200 dots per inch (dpi). Your
Macintosh converts the 200 dpi fax resolution to the 72 dpi of
the Macintosh screen. The conversion process concentrates gray
areas together, making the document appear darker. The
smoothing feature looks for dark areas, and then applies a
special algorithm known as dithering to improve document
resolution.
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Editing a fax
You may need to resequence, eliminate, or combine pages from several faxes.

Cutting a page
Entire pages can be cut to the Clipboard for later use.
1

Make sure you’re viewing the page you wish to cut.

2

Choose Cut Page from the Edit menu.

Cut Page cuts the entire page. Notice that the page count decreases by
one page.

Copying a page
Pages can be copied from a document to keep the original fax intact.
1

Make sure you’re viewing the page you wish to copy.

2

Choose Copy Page from the Edit menu.

The Clipboard holds one page at a time. Be sure to paste the page into a Fax
Viewer or Paint program document before copying another page. Notice that
the page count remains the same. Copied pages are not removed from the
current fax.

Pasting a page
You may paste a cut or copied fax page into any Fax Viewer or Paint program
document.
1

Select the page you want and cut or copy it to the Clipboard.

2

Use the Scroll Bar to display the page that will precede the page you want to paste in.

3

Choose Paste Page from the Edit menu.

Notice that the page count increases by one page and that Fax Viewer places
the page after the one displayed.
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Clearing a page
Clear Page deletes one page at a time.
1

Make sure you’re viewing the page you wish to delete.

2

Choose Clear Page from the Edit menu.

You can use Undo to restore the deleted page. The current page is deleted
from the fax and the following page takes its place in the order. Notice that
the page count decreases by one page.

Selecting a portion of a page
You may want to select a portion of a page for pasting into a document
created by another program, such as MacPaint. Fax Viewer provides a
selection rectangle tool for selecting and copying portions of documents.
1

Select the page you wish to copy from.

2

Move the pointer over the page.

Notice that the arrow pointer becomes a crosshair. It now functions as a
selection rectangle tool for selecting rectangular areas.
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3

Drag the selection rectangle tool across the image from the upper left to the lower right,
releasing the trackball or mouse button when the image is enclosed.

A moving dashed line encloses the selected image.

Moving dashed line

4

Selection rectangle tool

Choose Copy Selection from the Edit menu.

Fax Viewer places the selected image at current resolution in PICT format in
the Clipboard.
Note: To place a copy of your selection in the Clipboard at Actual Size
regardless of what the viewing resolution is, press x-Option while choosing
Copy Selection from the Edit menu.
5

Make your Paint program document the active window, and then choose Paste from the
File menu.

The selected image appears in your document.
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Resequencing a fax
By using a combination of Cut, Copy, Paste, and Clear Page, you can
resequence a fax. In fact, you can open several faxes and copy pages into a
new Fax Viewer document.

Printing a fax
You print a fax the same way you print any document. See “Print a
Document” and “Printing Your Work” in your Macintosh user’s guide. Make
sure the printer is selected in the Chooser.

Converting a fax document to a PICT file
Fax Viewer allows you to save in Fax Viewer or in PICT file format. Fax
Viewer documents can be opened only by the Fax Viewer program. PICT
files may be opened by other programs, such as MacDraw or TeachText.
In other words, the Save As command acts as a conversion tool for fax
documents.
1

Choose Save As from the File menu.

The Save As dialog box appears. Notice the pop-up menu, titled Format at the
bottom of the dialog box.
2

Change the document type using the Format pop-up menu.

In the following example, Fax Viewer is checked because the document is a
Fax Viewer document. Dragging to PICT selects PICT format.

3

When you’re finished, click Save.

The current page is converted to PICT format (72 dpi) and placed in the
folder of your choice.
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Conversion file formats

Use

Fax Viewer

Can be opened only by Fax Viewer

PICT 72 dpi

Standard PICT format

PICT 200 dpi

High definition PICT format

Fax Viewer is a program for viewing and manipulating the fax documents you
receive. Because a fax is a graphic image, it is similar to documents created in
a Paint program. This means that you cannot edit the text as you can in a
word processor.
IMPORTANT Fax files can be quite large in size. Check the size of your Sent

and Received Fax folders from time to time to make sure you are not running
out of disk space. It is best to delete faxes that you don’t need to keep. Print
them or make backup copies before deleting. You can use Fax Log to keep
transmission records.
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Forwarding a fax
Fax Viewer forwards your faxes in the same way Fax Terminal does.
1

Open a Fax Viewer document using any of the several methods, then choose Forward
Fax from the File menu.

. See also: “Opening a fax” earlier in this chapter.

Choosing Forward Fax
forwards an already imaged
fax in the Sent or Received
Fax Documents folders.

Choosing Fax Setup and then
Fax reimages an existing fax
document before sending.

The Fax Sender dialog box appears.
2

Forward your fax as you would in Fax Terminal.

. See also: “Forwarding a fax” in Chapter 4.
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6

Fax Cover

Fax Cover allows you to create, manage, and store fax cover pages.

In this chapter
m Customize the fields on a cover page
m Align fields
m Add graphics to a cover page
m Install and remove cover pages

Before you begin
You don’t have to attach a cover page to a fax before sending. If you wish to
use customized cover pages with your faxes, you must read this chapter.
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Customizing cover pages
Cover pages contain fields for address information. Each field has field title
and text. Field titles are labels, such as “To” and “From.” Field text is
information you enter, such as your recipient’s name. You customize a cover
page by rearranging the appearance and positions of the individual fields and
by adding graphics.

Customizing fields
You can decide which fields to display, change title names, edit field title and
field text appearance, and position and resize fields on the cover page.

Space for a
PICT graphic
Sender ID

Recipient ID

Field
Field title
Field text

Printable
page area
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1

Open the Fax Cover folder (installed on your hard disk) and double-click the Fax
Cover icon.

When a new cover page appears, it displays fields of titles and text. You can
identify field text by the angle brackets (< >) surrounding it. Text in angle
brackets acts as a placeholder for the text you enter in the Cover Page
Information dialog box and Fax Phone Book in Fax Sender.
2

Choose Show Fields from the Layout menu.

Initially, all fields are selected. The Show Fields command displays a dialog
box for specifying which fields will be shown on the cover page. Clicking a
field deselects it (removes the checkmark), and it will not appear on the page.
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3

Position the cursor on a field title to change the field title name.

Clicking a field title automatically selects the entire title. When the arrow
pointer is positioned over any part of a field title, it changes to an I-beam. You
can edit all or part of the field title by selecting and typing over existing
characters or by placing an insertion point in the field title and inserting or
appending characters.

4

To change the font, size, and style of the field title, select all or part of the field title and
use the Font and Style menus.

You can use Select All Field Titles from the Edit menu, or you can Shift-click
to select combinations of fields to edit simultaneously.
Use the Font menu to customize the font and size. Use the Style menu to
customize the style (bold, italic, and so on) and alignment (left, center,
and so on).
5

To change the font, size, and style of the field text, click anywhere in the text area to
highlight the field text and use the Font and Style menus.

You can use Select All Field Text from the Edit menu, or you can Shift-click
to select combinations of fields to edit simultaneously.
Use the Font menu to customize the font and size. Use the Style menu to
customize the style (bold, italic, and so on) and alignment (left, center,
and so on).
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Positioning and resizing fields
You can position and resize fields individually or in groups.
1

To select a field, click anywhere in the field text, not on the field title.

Clicking inside the field will highlight the text within the field, and handles
will appear at the field corners.

2

To resize the field, drag one of the handles.

If you choose a font, size, and style for the field that would require vertical
space greater than the current size of the field, the field will automatically
increase to the required height.

3

To reposition a field, drag the field by its center (not by a handle) to a new location on
the page.

When a field is being moved, the outline of both the field and its title will be
displayed to indicate that the field title is moving with the field.
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Using the grid
The grid allows you to align fields easily as you move them. When the grid is
turned on, fields that you move or resize will automatically snap to the
nearest grid line whether visible or not.
1

To turn the grid on, choose Turn Grid On from the Layout menu.

2

To see the invisible grid lines, choose Show Grid Lines from the Layout menu.

Aligning fields
You can align fields to the grid or to each other. The following examples show
you how to align three fields to the grid and then three fields to each other.
Example 1: Aligning fields to a grid
1

Shift-click three fields to select them.

You might choose fields at random in the following positions.
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2

Choose Set Alignment in the Layout menu.

The following dialog box appears.

3

Set Grid Spacing to 30 pixels.

4

Click the Align Objects To Grid button.

5

Click Left under the Horizontal option and None under the Vertical option.

6

Click OK.

The fields snap to the nearest left gridline.
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Example 2: Aligning fields to each other
Notice that the grid lines have been turned off in the Layout menu.
1

Shift-click three fields to select them.

2

Choose Set Alignment in the Layout menu.

The Set Alignment dialog box appears.
3

Click the Align Objects To Each Other button.

4

Click Right under the Horizontal option and None under the Vertical option.

5

Click OK.

The fields snap to the farthest right side of the farthest right field.
Note: To reuse the same alignment settings, just choose Align from the
Layout menu. The settings stay the same until you change them.
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Adding graphics
You can import previously created PICT graphics to a cover page and resize
and combine them with text. You can use the clipboard or the Import PICT
command in the Fax Cover File menu to import a PICT file.
1

Select a graphic to add to your cover page.

The following graphic was created with MacDraw and saved as a PICT file.
See your graphics software documentation to learn how to create graphics
and save them as PICT files.

IMPORTANT Only PICT files can be imported to cover pages.
2

Choose Import PICT from the Fax Cover File menu.

The Open file dialog box appears.
3

Double-click the name of the graphic you wish to import.

Use the scroll box and pop-up menu to find the PICT file you want.
Your graphic appears inside the printable area of the cover page form. You
can import up to sixteen PICT graphics into one cover page.
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4

To reposition the graphic, just drag it to a new location on the page.

You can resize an imported graphic by dragging the handles, and you can
move it to an empty space on the cover page or place it in the background
behind superimposed text fields. You may have to reposition the text fields to
find the best arrangement.
From :

<Sender Name>
<Title>
<Company>
<Address Line 1>
<Address Line 2>
<Address Line 3>
Fax Phone Number :

Voice Phone Number :

<Sender Fax Number>

<Sender Voice Number>

To :

<Recipient Name>
<Title>
<Company>
<Address Line 1>
<Address Line 2>
<Address Line 3>
Fax Phone Number :

Voice Phone Number :

<Recipient Fax Number>
Number of Pages :

<Number of Pages>
Subject :

<Subject>
Notes :

<Notes>
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<Recipient Voice Number>
Date :

<Date/Time>

You will be able to see your completed fax with the cover page at send time
by selecting Preview in the Fax Sender Print dialog box.
The sample cover page below was prepared with TrueType outline fonts.
Installing TrueType fonts will allow you to send fax text—even in large
character sizes—with excellent character definition.
BEMSHA

05.23.93

13:01

From:

Peter Edwards
President
XYZ Company
125 East Blvd.
Northern, Va 22999
Fax Phone Number:

Voice Phone Number:

(703) 555-3138

(703) 555-3840

To :

Brian Allen
Supervisor of Training
East West Furniture Co.
21212 Idlewild Drive
Raleigh, NC 29444
Fax Phone Number:

Voice Phone Number:

(919) 555-6789
Number of Pages:

(919) 555-6776
Date:

2

04/23/94

Subject:

Latest Figures
Notes:

Here are the latest cost projections for the next quarter.

F

A X

C

O V E R

91

Outline fonts and high-definition fax
To obtain the highest-quality printed text image, install
outline type fonts, such as TrueType fonts, on your system.
The fax imaging process takes a picture of your Macintosh
screen. Because the Macintosh screen has a much lower
resolution than the 200 dots-per-inch resolution of a fax
machine, bitmapped fonts will give you jagged character
edges. In contrast, outline fonts produce clear, crisp
images without “jaggies” across the entire range of font
sizes by mathematically scaling fonts to the selected size.
If you have outline and bitmapped fonts installed, be sure
to use only the outline fonts for cover pages and
documents. Outline fonts produce excellent results across
the entire range of font sizes.

Outline fonts

RR

RR
R

RR

Bitmapped fonts

92

C

H A P T E R

S

I X

Installing cover pages
A new custom cover page must be saved and then installed in the Fax Sender
cover page library. You install it only once. When you edit an existing cover
page, the changes are saved without reinstalling.
1

Choose Save As from the File menu.

2

Type a name for your cover page and click Save.

3

With your cover page open, choose Install Cover Page from the File menu.

The current cover page is installed in the Fax Sender cover page library under
the name you selected, in this case, “XYZ logo cover.” You will be able to
choose it from the Fax Sender pop-up menu at send time.

Note: To modify an installed cover page, open the cover page, modify it, and
then save it. The cover page remains installed.
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Removing a cover page
1

Choose Remove Cover Page from the File menu.

A dialog box appears with a list of all currently installed
cover pages.
2

Select the cover page you want to remove in the Remove Cover Pages scroll box.

3

Click Remove.

You can remove multiple cover pages by Shift-clicking their names to
select them.
IMPORTANT Once removed, a cover page will no longer be available in the

Cover Page pop-up menu in the Fax Sender Print dialog box. It still exists
as a Fax Cover document, however, and you can open, edit, and
reinstall it later.
4

Quit Fax Cover when you’re finished with the program.

Table 6-1 summarizes the options available in the Fax Cover menus.
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Table 6-1 Summary of Fax Cover menu options
Menu option

Action

File
Import PICT

Allows you to import a PICT file into a cover page.

Install Cover Page

Puts a cover page in a library of cover pages. Cover pages are available
from Fax Sender Cover Page pop-up menu.

Remove Cover Page

Removes an existing cover page from cover page library. Removed cover
pages can be reinstalled.

Edit
Select All Field Titles

Selects all field titles in an open cover page document.

Select All Field Text

Selects all field text in an open cover page document.

View
Actual Size

Sizes to real cover page size.

Fit in Window

Sizes to current window size.

Reduce

Offers 25%, 50%, 75%, and 100% views.

Enlarge

Offers 25%, 50%, 75%, and 100% views.

Layout
Show Fields

Allows you to choose the fields for cover page display.

Turn Grid On

Activates and deactivates grid.

Show Grid Lines

Makes grid visible.

Align

Aligns selected fields according to Set Alignment dialog settings.

Set Alignment

Allows you to set alignment parameters.

Use Default Size

Restores selected PICT to original size.

Font

Allows you to set font type and size for text.

Style

Allows you to set style and alignment for text.

Windows

Shows names of open cover pages.
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Technical Information

In this appendix
This appendix informs you about
m Express Modem control panel
m Turning the modem on and off
m Express Settings
m Express Status
m Communications Toolbox compatibility
m Call management
m Software specifications
m Hardware specifications
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Express Modem control panel
The Express Modem control panel is the nerve center for controlling and
monitoring modem functions.

Setting the modem
The Express Modem control panel contains a field for setting certain modem
functions. Most communications applications allow you to set the same
functions. It is important to understand how to override application settings.
Overriding application settings
Because the Express Modem opens associations with up to three applications
at a time (see Call Management in this Appendix), for the sake of easy
management, it is important to be able to override application settings.
Express Settings take precedence over application settings as explained below,
so remember to check Express Settings if an application does not behave as
intended.

Monitoring the modem
The Express Modem control panel contains a status field for monitoring
modem functions such as, call progress and connection state before, during,
and after a call is made.
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Turning the modem on and off
While on, the modem uses some of your system’s memory (600K). You may
want to turn the modem off when it isn’t needed. The On/Off buttons in the
Express Modem control panel indicate whether the modem software is
running.
However, you needn’t reset the Express Modem control panel to restart the
modem. Opening one of your communications programs opens the modem
application.
m To turn the modem off, open the Express Modem control panel and
click off.
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Express Settings
The Express Modem control panel contains a field for configuring
the modem.

Selecting Express Settings
1

Select Express Settings in the Express Settings/Status pop-up menu if not already
active.

The following field is displayed inside the Express Modem control panel.
Auto-Answer checkbox.
Supercedes applications
auto-answer controls.

Express Settings/Status
pop-up menu.

Blind dialing checkbox.
Turns blind dialing on and off.
Appears on certain
PowerBook models only.
Supercedes applications
modem speaker settings.

Select serial port according to
application requirements. See
Selecting serial port in this chapter.

2

Make choices according to the your needs.

Express Settings are explained below.
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Blind dialing
Blind dialing means that the modem dials out even though a dial tone cannot
be detected. Blind dialing is useful in certain situations, such as hotel rooms
where the modem may have difficulty recognizing the dial tone on the hotel
PBX. The ATX command controls blind dialing. Clicking the Ignore dial tone
when dialing checkbox has the effect of setting ATX=3 for all applications.
Leaving Ignore dial tone when dialing unchecked allows you to control blind
dialing at the application level.
. See also: ATX command in Appendix B.

Auto-Answer
Clicking the Do not answer incoming calls checkbox has the effect of setting
ATS0=0 for all applications, including terminal emulation and
communications programs, and takes precedence over all application settings.
In fact, once you have clicked this button restricting incoming calls, typing
ATS0=2 in a communications program, such as MacTerminal, will return OK,
but the modem will not answer and the modem profile won’t change.

Leaving Do not answer incoming calls unchecked allows you to control
auto-answer at the application level. You may wish to do this because you
want to answer manually with a certain application or for other reasons.
. See also: “Setting auto-answer at the application level” in this Appendix.
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Wake Macintosh on ring
Some PowerBook models have a special feature, Wake Macintosh on ring,
that will automatically wake up your Macintosh from system sleep to respond
to an incoming call. This allows you to conserve battery power while waiting
to receive a fax or a file. (See the Macintosh PowerBook user's guide for your
model for more information on system sleep.)

Speaker pop-up menu
The Speaker pop-up menu allows you to choose from three different settings.
Menu setting

Meaning

Use Application Settings

Allows you to control the speaker volume from the application
setting and Sound control panel.

Modem Sound Always Off

Turns the speaker off for applications that use the modem.
Same as setting ATM=0 for all modem applications.

Modem Sound On until Carrier

Leaves the speaker on until the carrier is established. Same as
setting ATM=1 for all modem applications.

Selecting the serial port
If you use a non-compatible CTB application, you should leave the Modem
Serial Port set to Use Express Modem.
If you use a CTB compatible application, you can leave the Modem Serial
Port set to Use External Modem.
If you then want to use some other serial device on your Modem Port after
this, you will need to reselect Use External Modem.
To use AppleTalk Remote Access, you can leave the Modem Port set to Use
External Modem. Use of AppleTalk Remote Access is described more fully in
Appendix C.
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Express Status
Express Status is for viewing call progress and modem status before, during,
and after connection.

Selecting Express Status
1

Select Express Status in the Express Settings/Status pop-up menu.

The status field appears.
Icon for your CPU
appears in this location.

Call progress and
modem status represented
in iconic form.

Connect, protocol,
and other messages.

Status messages about
type of call and modem status.

You can view the connection process by stages: idle, preparing for connection,
opening a connection, and during connection. Express Status monitors each
stage, displaying messages and icons You do not need to be connected to view
Express Status. For example, even while the modem is off or when you open a
connection to the modem in your communications program (the equivalent of
picking up the receiver), messages are displayed.
. See also: Express Modem status messages in Appendix C.
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Communications Toolbox compatibility
The Express Modem is designed to work with the Communications ToolBox
(CTB). The Express Modem Tool, a CTB connection tool, is designed to work
specifically with the Express Modem. If you use an application which uses
the CTB, it is preferable to choose the Express Modem Tool, rather than
selecting the Serial Tool, the Apple Modem Tool, or disabling the CTB.
The Express Modem provides access for those serial driver applications which
do not support the CTB. Selecting Use Express Modem in the Express
Modem control panel will enable applications using Serial Port A (Modem
Port) to communicate with the Express Modem.
Applications that use a non-standard means of accessing a modem (for
example, bypassing the serial driver and directly controlling the hardware, or
implementing an alternate to the standard serial driver) have no means of
accessing and using the Express Modem.
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Call management
Your modem is designed to manage communications with Express Fax,
AppleTalk Remote Access, and your communications program. This function
is known as call management.
Your computer has just one physical modem port, which appears on the back
panel where your modem is connected to the main logic board. To manage
calls, the Express Modem software creates three “logical” ports—that is, nonphysical ports. The Express Modem software generally sends incoming data
to the logical port associated with the program. In other words, the modem
sends fax data to the fax logical port, and so on. (For an exception to this rule,
read “Setting auto-answer at the application level” in this chapter.)
Even with call management, your modem can still only connect to one
telephone line at a time. If your modem is in use, and one of your
communications programs tries to dial out to a different number, a Modem in
use message is displayed in that program.
The modem serves your programs according to the following set of priorities:
Type of program

Priority

Data User programs
MacTerminal and other CTB
terminal emulator programs
or front-end programs, such
as AppleLink

Highest priority over other program types to allow
user control of modem at all times for both sending
and receiving data.

Data Server programs
AppleTalk Remote Access

Lower priority than Data User. Allows Data Server
and other servers to run in background while user
program controls modem. When Data User program
releases modem, Data Server is ready for incoming calls.

Fax Server programs
The Express Fax software

Same priority as Data Server. Runs in background
while user program controls modem. When Data User
program releases modem, Fax Server is ready for
incoming calls.
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Setting auto-answer at the application level
Express Fax, AppleTalk Remote Access, and your communications program
all contain an auto-answer command that sets your modem to answer calls
automatically. Each program’s auto-answer setting—the S0 register—affects
call management in the following ways:
m Only a Data User or a Server program (Fax or Data) is open.
M If the program is set to auto-answer, the modem answers after the
number of rings designated in the S0 register of the open program.
M If S0=0, the modem answers only when the manual answer command is
given.
m Both a Data User and a Server program (Fax or Data) are open.
M If both programs are set to auto-answer, the modem answers after the
number of rings designated in the Data User program.
If the call is a fax call, it is passed to the fax server.
If the call is intended for the data server, it is not passed to the data server
(data user programs take precedence over data server programs) because
the data port cannot distinguish between the two data programs.
M If the Data User program has set S0=0, the modem will not answer.
m Both Fax and Data Server programs are open.
M If both programs are set to auto-answer, the modem answers after the
number of rings equal to the minimum of the two S0 values. The call is
passed to the correct logical port.
M If one program has S0=0, the call is passed to the program whose S0>0,
if appropriate. If both server programs have their respective S0=0, the
modem does not answer, but calls may still be placed.
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Auto-answer is set differently for each type of communications program. If
you want to set auto-answer yourself, use the following table as a guide.
Type of program

How to set auto-answer

MacTerminal and other
terminal emulators

Set the program’s S0 register. See the program’s user’s guide for
information on setting the S0 register, or use the AT commands listed
in Appendix B.

AppleTalk Remote Access
and other servers

Use an AppleTalk Remote Access CCL script. CCL scripts are
included on the Express Modem disk. See Appendix C.

The Express Fax
software

Select Auto-Answer in Fax Terminal Fax menu and set the number of
rings in Fax Terminal Preferences. See Chapter 4.

You may also want to turn off auto-answer when your modem shares the line
with a telephone to make sure that the modem does not answer your
incoming calls before you do. Installing a separate phone line just for the
modem is another solution.

Answering manually
Communications software programs contain an Auto-Answer command that
sets your modem to manage calls automatically. The Auto-Answer command
sets your modem’s S0 register.
The modem cannot auto-answer a call if its S0 register is set to 0. In this case,
a communications program must be open and must issue the ATA command
in order to answer a call. (See Appendix B for information on the ATA
command—and all the AT commands.)
To set a communications program to issue the ATA command, see the
following table.
Type of program

How to manually answer (issuing the ATA command)

MacTerminal and other
terminal emulators

Issue the ATA command. For information, see the
AT command set listed in Appendix B.

AppleTalk Remote Access
and other servers

Use auto-answer in most cases.

The Express Fax
software

Choose Receive Manually in the Fax Terminal Fax menu.
See Chapter 4 for information.
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Software specifications
Command set
Extended Hayes AT command set
Data communications standards
14400, 12000, 9600, 7200, 4800 bps
9600, 4800 bps
2400 bps
1200 bps
1200 bps
300 bps
300 bps

CCITT V.32 bis
CCITT V.32
CCITT V.22 bis
Bell 212A
CCITT V.22
CCITT V.21
Bell 103

Group 3 Fax communications standards
2400, 4800 bps
7200, 9600 bps
12000, 14400 bps

CCITT V.27 ter
CCITT V.29
CCITT V.17

Error control
Full CCITT V.42 compliance
MNP Classes 2–4
Fax Error Correction Mode
Data compression
CCITT V.42 bis (up to 4:1 compression)
MNP Class 5 (up to 2:1 compression)
Dialing capability
Tone/pulse dialing
Auto or manual dialing and answering
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CCITT T.30

Data transmission and format
Full or half duplex operation
Asynchronous or framed modes
Character formats:
5, 6, 7, 8 data bits
1 or 2 stop bits
Odd, even, or no parity
Software
Modem application software includes:
Express Modem control panel
Express Modem Tool connection tool
Express Fax software includes:
Fax Terminal, Fax Viewer, Fax Sender, Fax Cover, Fax Extension
Memory requirements
The Express Modem uses 600 K of system RAM when the modem
application is turned on.

Hardware specifications
Your modem is compatible with your CPU.
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B

Modem Command Set

This appendix offers technical reference information for tuning and
controlling your modem. If you use front-end programs such as AppleLink or
programs like Express Fax included with your modem, or server programs
such as AppleTalk Remote Access, you may never need to use the AT
commands and other technical information in this appendix.

In this appendix
This appendix presents the AT commands recognized by your Express
Modem. Commands are listed alphabetically and numerically, and grouped
by functional category into tables.
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Modem states
The Express Modem has two functional states: command state and on-line
state. Command state allows you to enter commands that control the modem,
such as configuration parameters. In command state, the modem is not
capable of sending or receiving data. In on-line state, the modem sends and
receives data through the telephone system. To enter commands from the AT
command set, the modem must be in command state.

Moving between command and on-line states
When the modem is turned on or after reset, the modem always goes to
command state. It automatically enters on-line state after successfully making
a connection with a remote modem, either when answering or originating
a call.
While the modem is in on-line state, you can issue a command that takes it
back to command state. When you control the modem in this fashion, it is in
local command state. While in local command state you can send commands
to the modem from your keyboard.
1

Open your communications software program, and choose the option that lets you enter
AT commands.

Consult the user’s guide that came with your software to find out how to enter
AT commands from your keyboard.
2

Type the escape sequence +++.

Wait one second (or a period equal to the guard time set in register S12).
Do not type any other commands or make entries before or after the escape
sequence while you wait. After a moment the message OK will appear.
You may now enter AT commands. Once you have done so:
m To go back to on-line state, type ATO.
m To hang up, type ATH.

112

A

P P E N D I X

B

Using AT commands
A command example is:
AT&Q5DT2125556767
This command line instructs the modem to attempt a V.42 bis connection,
and then dial the number (212) 555-6767.
In this example, the modem’s command line interpreter—the AT command
set—issues instructions to the modem. If you look up these commands in this
appendix, you will find:
AT

The attention command

&Q5

Attempt V.42 bis connection

DT

Use Touch-Tone dial

212… Make this string the dialed number

Entering AT commands from MacTerminal
If you have MacTerminal, you can enter AT commands as follows:
1

Choose Connection from the Settings menu.

The Connection Settings dialog box appears.
2

Select the Express Modem.

The lower half of the dialog box changes.
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3

Select Direct AT Commands in Modem Settings, and then click OK.

4

Choose Open Connection from the Session menu.

This is equivalent to lifting the telephone off the receiver.
5

Enter the command string AT&Q5DT2125556767 on your keyboard, then press
Return.

The modem will dial the number and make the connection. The messages
displayed on your screen will be similar to the following:

6

To hang up:

m enter +++ to go to command state
m type ATH
m and then press Return.
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Commands documented in this appendix
This appendix documents the command set recognized by the Express
Modem. The command set is compatible with the V series Hayes AT
command set, a subset of the Microcom AX series MNP command set, and
the class 2 TR-29/89-21R7 AT+F Fax extension set. This document does not
describe the Fax AT+F subset.

Integrated (non-serial port) modems
Traditional modems—external modems or even modems that plug into a slot
on a main logic board—use an RS-232-like serial connection protocol
between the CPU (Data Terminal Equipment–DTE) and the modem (Data
Communications Equipment–DCE). Your modem does not use this type of
serial connection.
Since your modem has no DTE-DCE serial interface, all commands related to
the serial interface have no effect. The commands themselves still exist for
script compatibility reasons.

Command set rules
The command line can contain any number of commands and their options
as long as the total number of characters, not including the attention
characters or the line termination character, does not exceed 64, the length of
the command line buffer. With only a few exceptions, described later in this
appendix, the command line begins with the attention characters AT and ends
with a return character, called a carriage return <CR>.
If the command line exceeds 64 characters, the result code ERROR is
returned and no commands are executed. If the number of characters is less
than or equal to 64, the commands are processed in order from the AT to the
<CR>. If a command is invalid or unrecognized, processing of the command
line ends at that command. Any commands following the error are ignored
and the result code is returned to your computer.
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The commands can be either upper or lowercase characters. However, both
attention characters must be in the same case (for example, AT or at). The
modem must be in command state to recognize and execute these commands,
with the exception of the escape sequence.
When a line of commands is executed, only the last result code for the
command is displayed. If any command needs to display information
different from the result code, it will be displayed. All intermediate result
codes are canceled.
Interpreting the default
If a value required for a particular command is not supplied, your modem
will normally interpret the value as 0. The value supplied by the modem
when you do not alter it is called the default. It’s the value the modem
assumes when you first start it up or after the original factory settings are
restored. You can restore the original settings by using the AT&F command
described later.
Interpreting valid parameter ranges
Some commands are accompanied by options, typically 0 and 1. An italic n
appears beside the title of a command to indicate the availability of these
optional settings. If you use one of these commands without a number, the
modem assumes the value to be 0. Every optional value is evaluated in
modulo 256. For example, ATE1 yields the same result as ATE257 because
(1 mod 256) = (257 mod 256) = 1. After evaluating the argument modulo 256,
if the value is not supported then ERROR is returned. Any argument greater
than 999 in a command will generate an ERROR result code.
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Setting the S registers
The S command is used to assign values to various registers in the modem’s
memory. Most of the S registers deal with certain aspects of timing. You can
customize the behavior of the modem by setting the values in the S registers.
Whatever the setting of register S3, the <CR> character (ASCII 13) is always
recognized. The option in the Set Register command (Sn=) is also evaluated
modulo 256 before setting the register to the new value. See the S registers
for details of the effects of setting a given register value out of range.
Any attempt to set or read a reserved or unused register will generate an
ERROR.

AT command set
AT refers to the command prefix (attention sequence) that precedes each
command to the modem. With the exception of A/, all commands must be
preceded by AT and end with a carriage return <CR>. In this appendix, the
modem’s default value and description are shown in boldface type.

Special Commands
A/ Repeat last command The A/ command instructs the modem to repeat
the last command line. A command line termination character <CR> is
not required for the execution of this command that is; the command is
executed as soon as the slash is typed.
+++ Return to command state (escape sequence) The escape sequence is
used to force the modem back to local command state from on-line
state. Do not type any other commands or make entries before or after
the escape sequence for a period equal to the guard time set in register
S12 (default is one second).
The modem sends an OK result code to the terminal and switches to
command state.
The actual escape character is specified by register S2, expressed as the
ASCII value of the escape character (default is 43=+).
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Standard AT commands
AT The attention command prefix The prefix AT must precede every
command. The remainder of the command line contains commands for
the modem. The command line must end with a carriage return. If AT is
sent alone (that is, it is followed by a <CR>), then no command is
executed but an OK result code is returned.
A

Answer The A command forces the modem to go off-hook in answer
mode. The modem then starts sending the answer tone (CCITT answer
tone independent from the B setting) unless the modem is set for leased
line (&L command) state. If no carrier signal is received from the
telephone line within the number of seconds specified by register S7,
the modem goes on-hook.
This command must be the last on a command line. Sending any
character to the modem during call establishment will abort the
command and generate a NO CARRIER result code.

Bn Communication protocol category preference This command
determines which communication standard will be used for the next
connection.

D

0

CCITT mode

1

Bell 103 and Bell 212A, instead of V.21 and V.22, in case of
fallback

Dial This command signals the modem that the numbers, letters,
and commas that follow are all part of thetelephone number it
should dial.
You may include other dial command characters in combination with
the D command: T, P, comma (,), W, colon (:),“at” sign (@),
exclamation point (!), R, semicolon (;), and S=n. Each of these
optional modifiers is described in the following sections. For clarity
sake, you may also use other characters or symbols (for example,
parentheses, hyphens, and spaces) without affecting the number.
In addition to the digits 0 through 9, your modem can also dial the six
special characters (*, #, A, B, C, D) found on some Touch-Tone dial
telephones.
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T

Touch-Tone dialing All subsequent numbers are Touch-Tone
dialed until the P command (for pulse dialing) is selected.

P

Pulse dialing Selects pulse dialing, with the dialing speed fixed at
10 pulses per second.
You can mix Touch-Tone and pulse dialing within the same
telephone number. The digits immediately following a P command
will be pulse dialed; those following a T command will be
Touch-Tone dialed.

,

Pause The comma modifier introduces a delay time before dialing
the next dial character or executing the next character in the dial
string. The pause time is the value of the S8 register (default=2
seconds).

W

Dial tone detect The W modifier is used to make the modem detect
a dial tone before sending the next digit. If the tone has been
detected by the modem before the S7 register time delay, the
modem continues dialing the rest of the characters in the dial
string. If no tone is detected, the modem goes on-hook, returns the
NO DIAL TONE result code to the host, and enters the local
command state.
This modifier can be embedded anywhere in the dial string.
Example: ATDT9W5551234.

:

Calling Card tone detect Same as W. The colon can detect most
calling card tones. Place the colon in the dial string when you want
to detect a wider range of frequencies.

@

Wait for quiet answer before dialing For the time specified in the S7
register (default=50 seconds), the modem attempts to detect 5
seconds of silence. This period of silence confirms that the call has
been answered. When 5 seconds of silence are detected, the
modem dials the remaining numbers in the command line. The
remaining numbers may be a security code, another telephone
number, or an extension. If no quiet time is detected, the modem
hangs up and returns NO ANSWER. The following is an example
using the @ modifier:
atdt312555-1432@4622
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!

Flash This modifier causes the modem to go on-hook then back
off-hook, as if the receiver on the telephone set had been pressed
momentarily. This modifier can be placed anywhere in the dial
string.

R

Reverse mode The R modifier changes the modem from originate
mode to answer mode once the dialing process has been
completed. This command is used only at the end of the dial
string.
This modifier is used for compatibility with old originate-only
modems.

;

Return to local command state after dialing The semicolon (;)
modifier may be put at the end of the dialing command. It forces
the modem back to the local command state after dialing a
number. The modem does not attempt a connection. This allows
you to use the modem as a dialer (you must pick up the telephone
handset at the end of the dial command) or dialing numbers in two
or more steps.

S=n Dial telephone number stored at location n Dials telephone number
stored in location n, where n is 0, 1, or 2. You must have
previously saved the value with the AT&Z command.
L

Dial last telephone number Redials the last number dialed when
placed after the D command.

En Echo off/on When the echo is turned on, the characters sent to the
modem in command state are echoed back by the modem to the
host computer. The E command is functional only when the
modem is in command state.
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0

Turns off the echo command.

1

Turns on the echo command. This allows you to see that
characters you have sent to the modem have been received and sent
back.

Hn Hook (hang up)
When the modem is on-line, you must first enter the +++ escape
sequence to take the modem back to command state before issuing the
hang up command ATH.
0

Forces the modem on-hook. Hangs up the modem’s connection to
the telephone line.

1

Forces the modem off-hook.

In Information
0

Asks the modem for its product ID code.

1

Returns a modem code.

2

Returns OK.

3

Returns the modem’s country code.

4

Returns a list of modem features.

9

Returns Apple product code and firmware version of the modem.

Ln Speaker volume This command has no effect, as the speaker is a
component of the Macintosh and set in the Sound control panel. The
command is included for compatibility purposes.
Mn Speaker on/off/auto
0

Disables speaker.

1

Turns on the speaker until carrier is established.

2

Leaves the speaker on throughout the entire connection.

3

Turns the speaker on until a carrier is detected, except during
dialing.

Nn Communication protocol preference Sets the modem protocol.
0

Use S37 for speed selection. If S37=0, connect at highest
possible speed. Otherwise, connect at speed specified in S37.

1

Connect at highest possible speed according to value of S37.
Fallback if necessary.

2

Same as N1 for compatibility reasons.

Note: For N1 or S37=0, the setting of ATB is ignored. The modem
automatically determines Bell or CCITT mode.
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On Return to on-line state Returns modem to on-line state from command
state.

P

0

Is used to return to the on-line state after having entered the
command state using the escape sequence.

1

Same as above and will retrain the carrier (possibly at a lower
speed) before reentering on-line state.

Enable pulse dialing Sets the default dialing mode to pulse mode. This
command can also be used as a subcommand of the D command.

Qn Quiet (refer to command Vn)
0

Allows result codes to be sent to your screen.

1

Turns off the result code messages.

2

Returns result codes when originating a call, but not when
answering.

Sn Select an S register The S registers refer to memory locations used for
configuration.
Most of the S registers deal with some aspect of timing. The S
commands are used to assign values to various registers in the modem’s
memory.

n? The Sn? command (n=register number) is used for checking
the contents of a register. The result is always expressed as a
three-digit number, where the leading digits or all digits may be 0.
Sn=r is used to change an S register value (where n is the number of the
register and r is the assigned value).
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S registers
Default

Range

Units

S0 Number of rings to auto answer
0

0:255

Number of rings

The S0 register determines the number of times your telephone must
ring before your modem will automatically answer it. When S0 is set
to 0, the modem is in manual answer mode.
S1 Ring counter
0

0:255

Number of rings

The S1 register is cleared if no rings are detected throughout an
8-second interval. S1 is automatically set by the modem.
S2 Escape Character
43 <+>

0:127

ASCII Decimal

The S2 register determines the ASCII character to be used as the escape
character. The escape sequence is used to force the modem from the
on-line state to the local command state.
S3 Line-termination character
13 <CR>

0:127

ASCII Decimal

The S3 register determines the ASCII character to be used as the
line-termination character. No matter what value S3 is set to, ASCII 13
is always recognized.
S4 Line-feed character
10 <LF>

0:127

ASCII Decimal

The modem returns the ASCII character programmed in the S4 register
as the line-feed character when the modem sends response codes to the
computer.
S5 Backspace character
8 <BS>

0:127

ASCII Decimal

The S5 register determines the ASCII character to be used as the
backspace character.
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S6 Initial blind dialing wait
2

2:255

Seconds

The S6 register determines the number of seconds your modem waits
between the time it takes the telephone off-hook and when it actually
begins dialing. If the modem is not blind dialing, this register is ignored.
S7 Carrier wait
50

1:255

Seconds

The S7 register determines how many seconds the modem waits for a
carrier signal from a remote modem after the dial command line is
executed, or when answering an incoming call. If your modem does not
receive a carrier tone from the remote modem in the specified amount
of time, it hangs up and sends the NO CARRIER message.
S8 Pause time
2

0:255

Seconds

The S8 register determines the delay time for each comma (,)
encountered in the dial command line during the execution of the
D (dial) command.
S9 Carrier detect response time
6

1:255

1/10 second

The S9 register determines how long the carrier must be present before
being recognized by the modem.
S10 Disconnect timing
14

1:255

1/10 second

The S10 register allows you to specify how long an interruption is
necessary before the modem interprets the disruption as a loss of carrier
and hangs up.
If you enter 255, the modem ignores carrier detect status.
S11 Duration and spacing for DTMF dialing
95

50:255

Milliseconds

Register S11 is preset and should remain unchanged to ensure correct
dialing.
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S12 Escape code guard time
50

20:255

1/50 second

This value determines the length of time to wait for typing commands
before and after issuing the escape sequence.
S18 Self-test duration
0

0:255

Seconds

The S18 register determines the duration of the AT&T diagnostic
self-tests. If a non-zero value is chosen, the modem automatically halts
the test after the time period specified and returns to command state.
You must then issue an AT&T0 to actually exit the test. If S18 is zero,
the self-test continues until it is ended by issuing the escape sequence
to return to command mode followed by AT&T0.
S36 Negotiation failure treatment
5

0/3/4/5

Settings

Specifies action that should be taken when an attempt to connect in
error-control mode fails.
0

Attempts V.42 connection. Hangs up if remote modem does not
support V.42.

3

Makes asynchronous connection. No error control. Same as
AT&Q0.

4

Attempts V.42 connection. If attempt fails, attempts MNP 2–4
connection. If this fails, hangs up.

5

Attempts V.42 connection. If attempt fails, attempts MNP 2–4
connection. If this fails, attempts asynchronous connection.
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S37 Desired DCE connection speed
0

0/3/5:11

Settings

This value is used in conjunction with the ATN and ATB values to
determine which modulations are attempted when connecting.
0

Auto-mode Attempts to connect at the highest possible speed.

3

Attempts to connect at 300 bps.

5

Attempts to connect at 1200 bps.

6

Attempts to connect at 2400 bps.

7

Attempts to connect at 4800 bps.

8

Attempts to connect at 7200 bps.

9

Attempts to connect at 9600 bps.

10 Attempts to connect at 12000 bps.
11 Attempts to connect at 14400 bps.
S38 Delay before hang up
0

0:254

Seconds

Specifies the delay before hanging up. When S38 is set to 255, the
modem delivers all the data in its buffers before hanging up.
S46 V.42 bis data compression selection
138

136/138

Settings

136 V.42 only
138 V.42 with V.42 bis compression
S48 Feature negotiation action
7

0/3/7/128

Settings

Selects which error control features are allowed when making
connections.
0

Negotiation disabled: try only V.42.

3

Negotiation enabled without detection phase.

7

Negotiation enabled with detection phase.

128 Negotiation disabled: try MNP only. V.42 disabled.
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S95 Error control negotiation message option
32

4/8/32

Bits

A bit map to enable different result codes. Linked to ATW when ATW=1.

T

Bit

Value

Meaning

0–1

1

Not used.

2

4

Enables CARRIER messages only.

3

8

Enables CARRIER+PROTOCOL
messages only.

4

16

Not used.

5

32

Enables CARRIER+PROTOCOL+
COMPRESSION messages.

Enable tone (DTMF) dialing Sets the default dialing mode to
Touch-Tone mode. Can be used in dial string (default).

Vn Verbalize The V command allows you to choose how result codes are
displayed: as code numbers or as English words. Unless these messages
are being read by a program that does not easily recognize strings of
characters, the default setting (V1) is recommended.
0

Displays result messages as code numbers (non-verbal).

1

Displays result messages as English words (verbal).
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Verbalize result codes
0

OK Command is correct and has been completed

1

CONNECT Connection established

2

RING Incoming ring detected

3

NO CARRIER No connection or lost the carrier

4

ERROR Bad command

5

CONNECT 1200 Connection established at 1200 bps

6

NO DIALTONE Dial tone not detected in S7 seconds

7

BUSY Busy tone detected

8

NO ANSWER See ATD…@…

10 CONNECT 2400 Connection established at 2400 bps
11 CONNECT 4800 Connection established at 4800 bps
12 CONNECT 9600 Connection established at 9600 bps
15 CONNECT 7200 Connection established at 7200 bps
24 CONNECT 300/REL Connection with MNP 300 bps
25 CONNECT 1200/REL Connection with MNP 1200 bps
26 CONNECT 2400/REL Connection with MNP 2400 bps
27 CONNECT 4800/REL Connection with MNP 4800 bps
28 CONNECT 9600/REL Connection with MNP 9600 bps
29 CONNECT 7200/REL Connection with MNP 7200 bps
30 CONNECT 12000/REL Connection with MNP 12000 bps
31 CONNECT 14400/REL Connection with MNP 14400 bps
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Protocol negotiation progress codes that work with ATW1 and S95.
40 CARRIER 300 Carrier detected at 300 bps
46 CARRIER 1200 Carrier detected at 1200 bps
47 CARRIER 2400 Carrier detected at 2400 bps
48 CARRIER 4800 Carrier detected at 4800 bps
49 CARRIER 7200 Carrier detected at 7200 bps
50 CARRIER 9600 Carrier detected at 9600 bps
51 CARRIER 12000 Carrier detected at 12000 bps
52 CARRIER 14400 Carrier detected at 14400 bps
66 COMPRESSION: CLASS 5 MNP class 5
67 COMPRESSION: V.42BIS V.42 bis compression
69 COMPRESSION:NONE No compression
70 PROTOCOL:NONE Asynchronous mode
77 PROTOCOL:LAP-M Error control mode with LAP-M protocol
80 PROTOCOL:ALT Error control mode with MNP protocol
128 MODEM IN USE Modem already in use for this or another
application
Wn Progress result codes The ATW setting determines whether progress
result codes are displayed in addition to the ATX codes. Register S95
determines which progress result codes will be displayed.
0

Progress codes 40 through 80 disabled.

1

Progress codes 40 through 80 enabled.

2

Progress codes enabled; identical to W1.

When writing a CCL script, pay attention to result codes for scripts that
require a specific response. If progress codes are enabled, the following
strings appear on the screen during a connection (in this example,
V.22 bis connection with no error control):
m

CARRIER 2400

m

PROTOCOL:NONE

m

CONNECT 2400
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Xn Active result code The result codes listed in Vn are divided into subsets
that can be selected by the X command. Dial tone detection is enabled
by X2 or X4. Busy tone detection is enabled by X3 or X4. The
commands X0, X1, and X3 are appropriate for blind dialing. Blind
dialing means the modem dials out even though a dial tone is not
detected.
0

Selects result codes 0 through 4 and 8.

1

Selects result codes 0 through 5, 8, and 10 through 28.

2

Selects result codes 0 through 6, 8, and 10 through 28.

3

Selects result codes 0 through 5, 7, 8, and 10 through 28.

4

Selects all result codes.

Yn Remote break handling This command sets modem behavior for
responding to a long break signal received from a remote modem:
m

Greater than 1.6 seconds for an asynchronous connection.

m

An attention frame for MNP or V.42.

0

The modem ignores any long breaks received from the remote
modem.

1

On receiving a long break from the remote modem, the modem
goes on-hook (hangs up) and returns to command state.

2

On receiving a long break from the remote modem, the modem
returns to command state but remains connected to the remote
modem (does not hang up).

Zn Reset The Z command tells the modem to perform a software reset.
0

Loads Profile 0 into the active profile.

1

Loads Profile 1 into the active profile.

&Cn DCD options Since bus modems have no DTE-DCE serial interface,
this command has no effect and remains for scripting compatibility.
0–2 Return OK.
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&Dn DTR options Bus modems do not have a DTR line. For bus modems,
an on-to-off DTR transition occurs when you close the connection tool
or the application currently using the modem. In this case, the modem
goes on-hook.
This command has no effect and remains for scripting compatibility.
0-3 Return OK. Default value is 3.
&F Recall default profile The current active profile is replaced by the
default factory configuration.
&Gn Guard tones This command specifies whether guard tones should be
transmitted. Guard tones are used in some telephone systems to allow
proper data transfer over the network. They are not used in the United
States.
0

Disables guard tone.

1

Same as 2.

2

Sends 1800 Hz guard tone.

&Kn Local flow control This command specifies which kind of local flow
control is used. Since bus modems have built-in flow control
mechanisms between the DTE and the DCE, this command has no
effect. Flow control characters generated by the application software are
always passed to the line.
This command has no effect and remains for scripting compatibility.
0-5 Respond OK, no action taken.
&Ln Switched/Leased line This command affects the modem’s behavior
during the call setup and carrier handshake phases at the beginning of a
connection.
0

Selects switched (dial-up) line.

1

Selects conditioned leased line.

&Pn Pulse mode make/break ratio
0

Sets the dial pulse make/break ratio at 39%/61%.

1

Sets the dial pulse make/break ratio at 33%/67%.
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&Qn Connection mode This command allows you to enable and disable
error control mode. The &Q command setting has precedence over
\N command setting and registers S36 and S48.
0

Asynchronous mode (no error control, disables V.42 and MNP).

5

Error control mode Instructs the modem to make a connection
using V.42/MNP, and fallback as necessary (see S36 and S48
registers).

&Rn CTS/RTS Since bus modems have no DTE-DCE serial interface, this
command has no effect and remains for scripting compatibility.
0–1 Return OK.
&Sn DSR Since bus modems have no DTE-DCE serial interface, this
command has no effect and remains for scripting compatibility.
0–2 Return OK.
&Tn Self-tests The following diagnostic tests are provided. These tests are
available only when no error protocol is engaged. The duration of each
test is controlled by register S18.
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0

Terminate the test Used to terminate (escape from) a test in
progress and return to command state, if S18=0.

1

Local analog loopback Initiates a local analog loopback test. The
escape sequence must be entered to terminate this test. This mode
tests the local modem and the local data terminal equipment.

3

Local digital loopback Initiates a local digital loopback test. The
modem echoes characters back to the remote modem exactly as
received.

4

Enable the remote digital loopback Enables the modem to
respond to a remote modem attempting to place it in digital
loopback test. If a remote modem places the local modem in
remote digital loopback mode, the local modem echoes characters
back to the remote modem exactly as received from the remote
modem.

5

Disable the remote digital loopback Prevents the modem from
responding to a remote modem attempting to place it in the digital
loopback mode.

6

Remote digital loopback test In this mode, characters sent to the
remote modem are echoed back to the local modem exactly as they
were received by the remote modem. This mode tests both local
and remote modems and telephone circuits.

7

Remote digital loopback with self-test Initiates a Remote Digital
Loopback (like &T6) with self-test data pattern generation and
error checking.

8

Local analog loopback with self-test Initiates a Local Analog
Loopback (like &T1) with self-test data pattern generation and
error checking.

The tests terminate when an AT&T0 command is issued or when
register S18 expires. In the self-test mode, an error counter counts the
number of errors and sends the final result to the host at the end of the
test. The maximum number of errors that can be counted is 255.
Note: &T1 takes an optional parameter (a single character, A or O) to indicate
whether the analog loopback must be done in originate (default) or
answer mode.
&Un Trellis coding Enables/disables Trellis code modulation in V.32.
0

Enable Trellis coding.

1

Disable Trellis coding.

&Vn Display profiles Displays the following information:
m

Active profile

m

Stored profile 0

m

Stored profile 1

m

Stored telephone numbers (see AT&Z).

&Wn Profile saving This command saves the current active profile:
0

Saves the active profile into profile 0.

1

Saves the active profile into profile 1.
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&Xn Synchronous clock source Ignored. Always returns OK. The modem
does not support synchronous modes.
&Yn Specify start-up profile Allows choosing between two different
configurations at start-up.
0

Specifies saved profile 0 as start-up configuration.

1

Specifies saved profile 1 as start-up configuration.

&Zn=s Store phone number
Stores the dial string s (64 characters maximum) in location n. The
value of n can be equal to 0, 1, or 2. Note that the dial string s is
constructed in the same fashion as the ATD command. It therefore must
be the last command on the command line and no other characters
should follow it in the dial string.

MNP-specific AT commands
\Bn Send break Sends a break on the line for n times 100 milliseconds
(n ranges from 1 to 9).
%Cn Compression enable Enables/disables MNP Class 5 data compression
during MNP reliable connections.
0

Disables data compression.

1

Enables MNP 5 data compression.

\Gn DCE flow control Enables/disables modem-to-modem flow control.
Coupled with \X, it determines whether flow control characters are
passed through or filtered.
0

Disables modem-to-modem flow control.

1

Enables modem-to-modem flow control.

\Nn MNP feature selection Determines whether MNP error control is used
in connections. The \N command setting also updates register S36.
The &Q command setting has precedence over \N command setting and
registers.
0-1 Normal mode MNP disabled.
2
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Reliable mode The modem will interrogate the remote modem for
MNP capabilities. If the remote modem does not support MNP, the
local modem hangs up.

3

Auto-reliable mode The modem interrogates the remote modem
for MNP capabilities. If the remote modem supports MNP, a
reliable connection is established. If the remote modem does not
support MNP, a normal connection is established.

\O MNP link negotiation Treated as ATO0 command. Modem returns to
on-line state. MNP Link is not negotiated.
\Tn Inactivity timer Where n is a decimal integer between 0 and 90
specifying minutes. Sets the number of minutes the modem waits before
automatically hanging up when data is not sent or received. The default
option n=0 disables the timer.
\U MNP link negotiation Treated as ATO0 command. Modem returns to
on-line state. MNP link is not terminated.
\Vn MNP result codes
0

Disables modified MNP result codes.

1

Enables modified standard MNP result codes 24 to 28.

2

Returns OK. No effect.

\Xn Flow control processing
0

No pass-through flow control If modem-to-modem flow control
is enabled, AT\G1, XON/XOFF characters received from the line
are filtered out of the data stream; they are not passed to the DTE.

1

Pass-through flow control If modem-to-modem flow control is
enabled, AT\G1, XON/XOFF flow control characters received from
the line are passed through to the DTE.

\Y MNP link signaling Treated as ATO0 command. Modem returns to
on-line state. MNP link is not negotiated.
\Z MNP termination Treated as ATO0 command. Modem returns to
on-line state. MNP link is not negotiated.

M

O D E M

C

O M M A N D

S

E T

135

ASCII character set

136

ASCII
code

Character

ASCII
code

Character

ASCII
code

Character

ASCII
code

Character

0

NULL

32

space

64

@

96

`

1

SOH

33

!

65

A

97

a

2

STX

34

"

66

B

98

b

3

ETX

35

#

67

C

99

c

4

EO

36

$

68

D

100

d

5

ENQ

37

%

69

E

101

e

6

ACK

38

&

70

F

102

f

7

BELL

39

'

71

G

103

g

8

BS

40

(

72

H

104

h

9

HT

41

)

73

I

105

i

10

LF

42

*

74

J

106

j

11

VT

43

+

75

K

107

k

12

FF

44

,

76

L

108

l

13

CR

45

-

77

M

109

m

14

SO

46

.

78

N

110

n

15

SI

47

/

79

O

111

o

16

DLE

48

0

80

P

112

p

17

DC1 (XON)

49

1

81

Q

113

q

18

DC2

50

2

82

R

114

r

19

DC3 (XOFF)

51

3

83

S

115

s

20

DC4

52

4

84

T

116

t

21

NAK

53

5

85

U

117

u

22

SYN

54

6

86

V

118

v

23

ETB

55

7

87

W

119

w

24

CAN

56

8

88

X

120

x

25

EM

57

9

89

Y

121

y

26

SUB

58

:

90

Z
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z

27

ESC

59

;

91

[
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{

28

FS

60

<

92

\

124

|

29

GS

61

=

93

]

125

}

30

RS

62

>

94

^
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~

31

US

63

?

95

_
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Tips and Troubleshooting

In this appendix
Your modem is designed to provide years of trouble-free service. Should
difficulties arise, however, this section may provide a quick solution. A good
rule of thumb for solving any problem is to start by checking the installation
and telephone line.
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Checking the installation
Problems that arise during setup can often be remedied simply by
double-checking the installation.
1

Unplug and reconnect the telephone cord to ensure a good connection. Check all other
connections.

2

To make sure that the modem is turned on, choose Control Panels from the Apple menu
and Double-click the Express Modem control panel icon.

The Express Modem control panel appears. If the On button is not selected,
click On. If you click the On button and it doesn’t stay selected or if the
Express Modem control panel doesn’t appear, see the resource materials that
came with your Macintosh for a service number to call. Your service provider
will make sure that the modem software is correctly installed on your
computer and that your modem is functioning properly.
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Checking the telephone line
Make sure your modem is communicating with the telephone line.
1

Choose Control Panels from the Apple menu. Double-click the Sound control panel icon.

2

Be sure the volume is set above the lowest mark.

3

Close the Sound control panel.

Increasing the volume does not affect the status of your modem. It just allows
you to verify that there is a dial tone when you try to open communications,
and that the modem can dial telephone numbers.
4

Open your communications software and enter terminal mode.

If you don’t know how to enter terminal mode, see your communications
software user’s guide. Terminal mode means that any characters that you type
on your keyboard will be sent to your modem and that any characters
received by your computer from your modem will be displayed on your
screen.
5

Try dialing your own telephone number.

You’ll hear a busy signal if you are properly connected.
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6

Type ATH1 and press Return (or choose the Dial command of your application).

If the modem is properly connected to the telephone line, you’ll hear a dial
tone. You can then type ATH0 to hang up (or choose the hang up command of
your communications software).
7

If you don’t hear a dial tone, test your telephone line by connecting a working telephone
and cord to the line.

Plug the telephone into the wall jack to verify the dial tone. If there is none,
you will know the telephone line is the source of the problem.
8

If you hear a dial tone on your telephone but not through your modem, test your
modem’s telephone cord by connecting it to the wall jack and to the telephone.

If there is no dial tone, the telephone cable is the source of the problem.
Return it to your dealer for replacement.
9

If your modem still has no dial tone, see the service and support information that came
with your computer for a number to call.
WARNING If your modem needs repair, take it to an authorized Apple

service provider.

140

A

P P E N D I X

C

Verifying that your software is installed
To be sure that the Express Modem software is properly installed, watch the
bottom of your screen when you restart your computer. You will see the
Modem and Fax icons, as illustrated below. If the Express Modem software is
installed, the icons are animated: the paper emerges from the fax machine on
the fax icon and the buttons on the phone are pressed on the modem icon.

You can also check the Express Modem control panel. If the Express Modem
software is installed and the modem application is open, the Modem button in
the Express Modem control panel will be on.
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Common problems
In terminal mode, I type AT and press Return once, but don’t get an
OK response.
m If you’re unable to get the OK response, check that all telephone cables are
securely in place and that your software displays the correct settings.
m If you still have trouble getting your modem to work, see the service and
support information that came with your computer for a number to call.

I want to reset the modem.
You can reset your modem—that is, return it to the original factory default
setting—by using an AT command.
m To reset your modem, type the direct command “AT&F”.
The AT commands may not be echoed on the screen when you type them.
Resetting the modem should also correct this problem.

I see unreadable characters mixed in with normal characters.
You may see a strange mix of characters in an otherwise readable message.
This may be due to noise or interference on the telephone line.
m Wait a while. The problem may go away by itself.
m If the problem persists, hang up then redial.

I have Call Waiting and experience loss of connection
If you use your modem on a telephone line with Call Waiting, you run the
risk of being disconnected or losing data when someone else tries to call. The
best solution is to temporarily disable Call Waiting if possible. In certain
cases, you may solve the problem by placing *70 or *71 in your dial string,
either before or after the number you are dialing.
Call Waiting will return as soon as you hang up. You will have to disable it for
each telephone call. Call Waiting can also be disabled for fax.

142

A

P P E N D I X

C

I see a complete screen full of unreadable characters.
A complete screen of random text may be caused by a bad connection, or
may occur when your modem’s automatic settings don’t match those required
by the remote computer.
Here are some possible solutions:
m Reconnect your telephone cord firmly. It doesn’t happen often, but an
improper connection can turn your data into unreadable text.
m If the problem persists, hang up and dial again.
m If you are sure you have a normal connection, but the problem persists,
check with your communications software user’s guide to confirm that your
modem is set correctly for speed, error checking, and data compression.
m Check with the person (or information service) at the other end of the line
to be sure your transmission rates (14400, 9600, 4800, 2400, 1200, 300 bps)
are the same.
m Try another parity setting until the transmission is normal.
m If you can’t see what you type, turn on your local echo setting (some
software applications call this the duplex setting). If you see two of
everything you type, turn off your local echo setting. An incompatible echo
setting can cause double lines of text to appear on your screen; it can also
prevent any text from appearing on the screen.
m Try another setting until the transmission is normal.
To manually set speed, parity, and other parameters, see “Reaching another
modem” in Chapter 2 and look for information on adjusting settings in your
communications software user’s guide.
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I have trouble connecting to the remote modem
m Make sure you are calling the correct telephone number. Verify that the
number has not been discontinued.
m You may need to type a digit, such as a 0 or 9, at the beginning of the
telephone number to get an outside line.
m Make sure that the number you’re dialing connects to a modem and not to
a regular telephone. Try calling the modem number from a regular
telephone. If you hear a high-pitched tone after you dial, you have reached
another modem.
m If the problem persists, try the recommendation on “Connecting to older
modems” later in this appendix.
Do not reconnect a faulty modem until it has been repaired. If you leave a
faulty modem connected when it is adversely affecting the telephone line, the
telephone company may disconnect your service until you have corrected the
problem.

I have trouble connecting to a remote fax
m If telephone line quality is poor, you may need to send the fax several
times.
m The high-speed fax feature (V.17) allows you to send and receivg at 14400
bps. If the remote fax does not support V.17, turn it off in Fax Terminal
Preferences.
m Error Corrected Mode (ECM) permits sending and receiving under poor
conditions and over cellular lines. If the remote modem does not support
ECM, turn it off in Fax Terminal Preferences.
Try sending faxes with both V.17 and ECM turned on. If you encounter
difficulties, turn off V.17 first. If the problem persists, turn off ECM.
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Other screen display problems
If you have screen display problems other than the ones listed in this
appendix (such as lines of text running off the screen), you may have a
problem with your communications software.
The problem generally shows up as soon as you begin to send or receive data.
Check the user’s guide that came with your communications software to
confirm that your modem is set correctly.
If you’re dialing an on-line service, verify that your system is set to match
what the service requires.
The following table lists some of the display problems you may encounter.
Solutions will vary depending on your communications software.
What you see

Possible cause

Possible solution

Data sent by the remote
modem appear as random
text on your screen.

Speed (bps rate),
parity setting, or data bits
setting is incorrect.

Consult your software
manual, call your on-line
service to find out what
bps rate is expected,
or experiment until you
find a bps rate that works.

Data appear as double
characters.

Both correspondent’s
and your software are
echoing characters.

Turn off your local echo;
that is, change to a full
duplex setting.

Lines of incoming data
are double-spaced.

Both correspondent’s
and your software are
sending line-feed
(also called newline)
commands.

Turn off your program’s
line-feed (or newline)
command.

Incoming data write over
the same line.

Correspondent expects
your software to begin
a new line.

Turn on your program’s
line-feed (or newline)
command.

Incoming characters
disappear off the right
side of the screen.

Correspondent expects
your software to provide
word wrap.

Turn on your program’s
word wrap command.
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Messages and alerts
Express Modem control panel status messages
The modem is off.

The modem software is not running.
The modem is on.

The modem software is running.
The modem cannot be run on this Macintosh.

The modem software is not properly installed. Try reinstalling your modem
software from the disk that came with your Express Modem.
The modem is set to receive a fax.

Fax Terminal Preferences is set to Auto-Answer. The modem is waiting for a
call.
The modem is set for data.

Communications software has opened a connection. The modem is waiting
for a call.
The modem is set for data and fax.

Fax Terminal Preferences is set to Auto-Answer and Communications software
has opened a connection. The modem is waiting for a call.
The modem is being used for fax.

A fax is being sent or received.
The modem is being used for data.

Data is being sent or received.
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Express Modem Tool alerts
There is not enough memory to open the connection. Closing windows or quitting
application programs can make more memory available.

You can also use virtual memory or acquire more memory from your dealer.

Express Fax messages
Manual fax reception has failed because the modem is not available. Please check that
the modem is correctly set up.

To find out why manual fax reception failed, check the Express Modem
control panel.
Fax reception has been deactivated because the modem is not available. Please check
that the modem is correctly set up.

To find out why manual fax reception failed, check the Express Modem
control panel.
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Connecting to older modems
Certain computers may have older modems that do not support the speeds,
error control methods, or data compression types your modem is using. If you
try to connect to such a computer using your modem’s automatic settings, your
modem may disconnect in which case you’ll get a No Carrier message.
If you are using communications software:
1

Open your communications software.

2

Open the Connection Settings dialog box.

3

Choose None under Data Settings in the Data Features pop-up menu.

This forces the modem to connect in a mode acceptable to the remote modem
and at the highest speed it can support.
4

Match your Data Settings to those of the remote modem.

You can also change the Data Settings once you have connected to the remote
modem by simply reselecting Connection from the Settings menu.
If you are using AT commands (see Appendix B):
m Use the AT&Q command to force the modem into asynchronous mode.
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Setting up AppleTalk Remote Access
Connecting to your office network with AppleTalk Remote Access allows you
to use all the Chooser devices from your office Macintosh AppleTalk
network, including printers, servers, and electronic mail.
To enable you to use AppleTalk Remote Access, a file containing special
commands, called a CCL file, is included on your modem installation disk.
You must put the file in your Extensions folder before using AppleTalk
Remote Access.
IMPORTANT For Data Server programs, such as AppleTalk Remote Access,

which do not use the modem connection tool, a serial driver replacement
translates serial driver information to a modem connection tool equivalent. In
this way, non–modem connection tool applications function as if they were
using an external modem over serial port A.
If the Express Modem 14400 CCL does not appear when you open the
Modem pop-up menu in the Remote Access Setup control panel, you should
use the following procedure:
1

Make sure AppleTalk Remote Access is properly installed.

2

Insert the Express Modem Disk in your disk drive and double-click the disk icon, if
necessary, to open the disk window.

3

Open the Modem Documents folder.

4

Drag the Express Modem 14400 CCL icon from the Modem Documents folder into your
Extensions folder in the System folder on your hard disk.
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5

Double-click the Remote Access Setup control panel.

6

Click the Modem pop-up menu and choose the Express Modem 14400 CCL and Internal
Modem from the Port pop-up menu.

7

Close the Remote Access Setup control panel and open the AppleTalk Remote Access
program.

Refer to the AppleTalk Remote Access User’s Guide to continue the connection
procedure.
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Setting up AppleLink
To enable you to use AppleLink, a CCL file containing special commands is
included on your modem installation disk. You must put the file in your
AppleLink Connection Files folder if you want to use AppleLink with your
modem.
IMPORTANT In front-end applications such as AppleLink, the CCL script is

used to select the modem connection tool automatically. All commands to the
modem are made by menu selection.
1

Insert the Express Modem Install in your disk drive and double-click the disk icon, if
necessary, to open the disk window.

2

Open the Modem Documents folder.

3

Drag the Express Modem CCL icon from the Modem Documents folder into your
AppleLink Connection Files folder on your hard disk.

4

Open AppleLink and choose Set up Connection from the Network menu.

5

Select Express Modem CCL from the Connection File pop-up menu.

Using this CCL file makes setting Modem Speed or Connection Port
unnecessary.
. See also: Getting Started With AppleLink 6.1, which comes with your
AppleLink package, for more information on setting up an AppleLink
connection.
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Glossary

A
analog data Data in the form of continuously variable physical quantities.
Compare digital data.
analog loopback test A simple self-test that directs the modem to display

characters on the monitor screen as they are typed.
analog-to-digital converter A device that converts data from analog to

digital form.
analog transmission Transmission of a continuously variable signal as opposed

to a discretely variable signal. Physical quantities such as temperature are
continuously variable and so are described as analog. Data characters, on the
other hand, are coded in discrete separate pulses or signal levels, and are
described as digital. The normal way of transmitting a telephone or voice
signal has been analog, but now digital encoding is coming into use over
trunk lines. Compare digital signal.
answer mode The connection mode in which the modem answers the

telephone.
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application program A program that puts the resources and capabilities of the
computer to use for some specific purpose or task, such as word processing,
database management, graphics, or telecommunications.
ASCII Pronounced “ask-ee,” an acronym for American Standard Code for

Information Interchange; a code in which the numbers from 0 to 127 stand
for text characters (including the alphabet, digits 0–9, punctuation marks,
special characters), and control characters. Used for representing text inside a
computer and for transmitting text between computing devices.
asynchronous Not synchronized by or with a clocking signal.
asynchronous transmission Transmission in which each information character
is individually synchronized, usually by the use of start and stop bits. The gap
between each character isn’t necessarily fixed. Compare synchronous
transmission.
auto-answer A modem capability that allows automatic “pickup” when the

phone rings.
auto-dial The ability to make a connection with another modem

automatically.

B
background application An application that runs without the user knowing.

May have a user interface, but usually starts itself.
baud Unit of analog signaling speed taken from the name Baudot. The speed

in baud is equal to the number of signal events per second, regardless of the
information content of those signals. Compare bps.
BBS Bulletin Board System. A small database, usually accessible free of

charge, in which you can share information and programs with other
computer users.
binary The representation of numbers in terms of powers of 2, using the

digits 0 and 1. Commonly used in computers, since the values 0 and 1 can
easily be represented in physical form in a variety of ways, such as the
presence or absence of current, positive or negative voltage, or a white or
black dot on the display screen.

154

G

L O S S A R Y

bit A binary digit (0 or 1); the smallest possible information unit, consisting
of a simple two-way choice, such as yes or no, on or off.
bitmapped fonts Characters composed of pixel maps. As size is increased,

character edges become more jagged.
blind dialing Blind dialing allows the modem to dial out even when no dial

tone can be detected.
bps (bits per second) The basic unit for measurement of digital data

communications transfer rate. Usually refers to the rate at which the
information is transmitted. Sometimes inaccurately refered to as the baud
rate.
buffer The memory region for temporarily storing data for display or later

use.

C
carrier A signal of known characteristics (for example, frequency) that is

altered (modulated) to transmit information.
CCITT Comité Consultatif International Télégraphique et Téléphonique, an
international organization that devises and proposes recommendations for
international telecommunications.
CCL An abbreviation for communications control language. This language is

used to write connect sequence files, sometimes called CCL files or scripts.
channel (1) In data communications, a one-way path in data communications

along which signals can be sent between two or more points. Contrast with
circuit. (2) In telecommunications, a one- or two-way transmission path
between two or more points. Provided by a common carrier; also called a
link, line, circuit, or facility.
character Any symbol that has a widely understood meaning. Some

characters, such as letters, numbers, and punctuation, can be displayed on the
monitor screen and printed on a printer. Others are used to control various
functions of the computer (see control character).
checksum A method that confirms that a unit of data contains the correct

information.
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circuit A two-way path along which signals can be sent between two or more

points. See also channel.
code A number or symbol used to represent some piece of information in a

compact or easily processed form.
command A communication from the user to a computer system (usually

typed from the keyboard) directing it to perform some immediate action.
command state The state the modem is in when keyboard input is recognized

by communications software as command codes to be executed. Contrast with
terminal mode and on-line state.
communications session The condition of being connected to and accessible

by another computer.
configuration A list of changeable modem characteristics that must be

properly set to allow a computer to communicate with a modem.
connector A physical device such as a plug, socket, or jack used to connect
one hardware component of a system to another.
connect time The amount of time spent on line with an information service,

usually billed at an hourly rate.
control character Any character assigned a numeric ASCII value inferior to

the Space character. Also, a symbol you can create by pressing one of your
computer’s keys while holding down the Command key. These symbols are
not usually printed, and are generally used to control screen formatting.
crosshair pointer The tool used to select a portion of a page in a PICT or Fax

Viewer file.
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D
data Any type of information, such as numbers, letters, or symbols, that can
be processed by a computer.
database A collection of information organized in a form that can be

accessed and processed by a computer system.
data communications A broad term covering any exchange of information

between computers or similar systems over telephone lines or computer
networks.
data compression The various methods used to save storage space by reducing

or eliminating gaps, redundancies, empty fields, or unnecessary data.
data server program A program that passively awaits an incoming call for

connecting to a server. AppleTalk Remote Access is an example of a data
server program.
data user program A terminal emulation or front-end program that takes

control of the modem and places an outgoing call. Has priority over server
programs.
dB The abbreviation for decibel, the unit of measurement for sound volume.
DCE An abbreviation for Data Communications Equipment. A device like
your modem used to establish and transfer data across a communications link.
decimal The common form of number representation used in everyday life, in

which numbers are expressed in terms of powers of 10, using the ten digits 0
through 9.
default A value, action, or setting that is automatically used by a computer
system when no other explicit information has been given.
demodulate To recover the information being transmitted by a modulated
signal; for example, a conventional radio receiver demodulates an incoming
broadcast signal to convert it into sound emitted by a speaker.
device A piece of equipment connected to a computer. A modem is a device.
dial tone A call progress signal returned by a telephone switching machine to

indicate that it is ready to accept a telephone number.
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digit (1) One of the characters, 0 through 9, used to express numbers in
decimal form. (2) One of the characters used to express numbers in some
other form, such as 0 and 1 in binary or 0 through 9 and A through F in
hexadecimal.
digital data Information represented by a code consisting of a sequence of
discrete elements. Compare with analog data.
digital signal A discrete or discontinuous signal; one whose various states are

discrete intervals apart. Compare with analog transmission.
digital-to-analog converter A device that converts data from digital to analog

form.
dithering A process for improving the resolution of displayed images.
DTE An abbreviation for Data Terminal Equipment. A device like your

computer that stores, displays, and processes data received from another
computer.
duplex transmission Two-way transmission.

E
echo To send a signal back to the originating device for display or

verification.
error code A number or other symbol representing a type of error.
error control A process that breaks down data into blocks, and then calculates

a checksum. The data is transmitted with the checksum so that the remote
computer can verify data integrity.
error message A message displayed or printed to notify the user of an error or

problem in the execution of a program.
even parity Use of an extra bit set to 0 or 1 as necessary to make an even

number of 1 bits in a character. For example, the 7-bit ASCII code for the
letter A (1000001) has two 1 bits; for even parity, the transmitting device
appends an eighth bit equal to 0 so that the total number of 1 bits remains
even (01000001). The receiving device can count the bits as a way of checking
for transmission errors.
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F, G
facsimile (dedicated fax) machine A machine that can scan a page and then

transmit the image of the page over telephone lines; a receiving machine
prints a copy of the original page.
fallback The process modems use to find a common connection speed,

starting at the highest rate supported or set by your modem.
fax server program A program that passively awaits an incoming call for
sending and receiving faxes. Express Fax is an example of a fax server
program.
flow control A method of signaling between computers so that pauses in data
transmission allow time for data to be received.
font In typography, a complete set of characters, letters, and symbols in one

size and style.
foreground application An application that runs under user control. When

several applications are running, only one foreground application is accessible
(or active).
format The form in which data is stored, manipulated, or transferred.
full duplex (1) A setting causing characters that you enter on your computer

to be echoed from a remote system. (2) A four-wire communications circuit
or protocol that allows simultaneous two-way transmission.
Group 3 fax A digital document facsimile transmission procedure on the

Public Switched Telephone Network.
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H
half-duplex (1) A setting causing characters that you enter on your computer

to be echoed not from a remote system but on your screen. (2) A two-wire
circuit designed for communications in either direction but not both
directions simultaneously.
handshaking A protocol for devices to exchange information about the

communications connection itself, such as when to start and stop transmitting.
hertz The unit of frequency measurement. For example, 1 hertz equals 1

cycle per second. Abbreviated Hz.
hexadecimal The representation of numbers in terms of powers of 16, using
the digits 0 through 9 and the letters A through F. Hexadecimal numbers are
easier for people to read and understand than binary numbers but can be
converted easily and directly to binary form. Each hexadecimal digit
corresponds to a sequence of four binary digits, or bits.
host computer The Macintosh in which your modem is installed.

I
input (1) Information transferred into a computer from some external source,
such as the keyboard, a disk drive, or a modem. (2) The act or process of
transferring such information.
integrated circuit An electronic component consisting of many circuit

elements fabricated on a single piece of semiconducting material, such as
silicon.
interface The devices, rules, or conventions by which one component of a

system communicates with another.
I/O Input/output; the transfer of information into and out of a computer.

See also input.
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J
jack A socket used for a telephone line or other electrical connections.
jaggies Jagged character borders that occur when viewing on-screen

bitmapped fonts. Characters are composed of separate pixels.

L
local echo A method of communication in which your modem or software

displays data “locally” on your screen, without relying on the host computer
to echo the characters back.
log off To type a command to the host computer that terminates the

communications session.
log on To enter a series of responses to prompts by the host computer to

identify yourself, your password, sometimes your terminal, and so forth, to
start a communications session.

M
mainframe computer A large computer whose speed and storage capacity allow

it to handle huge amounts of data and work with many terminals.
millisecond One thousandth of a second; abbreviated ms.
MNP An abbreviation for Microcom Networking Protocol. MNP Classes 2–4

are error control protocols. MNP Class 5 is a data compression protocol.
modem A device for converting serial information into tones that can be

transmitted over telephone lines. The tones are modulated (changed in pitch)
to represent the information; modem stands for “modulator/demodulator”.
modulate To modify or alter a signal to transmit information; for example,
conventional broadcast radio transmits sound by modulating the amplitude
(amplitude modulation, or AM) or the frequency (frequency modulation, or
FM) of a carrier signal.
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O
odd parity Use of an extra bit set to 0 or 1 as necessary to make the total
number of 1 bits in a character an odd number. For example, the 7-bit ASCII
code for the letter A (1000001) has two 1 bits; for odd parity, the transmitting
device appends an eighth bit equal to 1 (11000001) so that the total number of
1 bits remains odd. The receiving device can count 1 bits as a way of
checking for transmission errors.
off-hook Your equipment takes control of the telephone line (picks up the

receiver).
on-hook Your equipment releases (hangs up) the telephone line.
on-line state The state the modem is in when data is being exchanged with

another computer over the telephone line. Contrast with terminal mode.
originate mode The connection mode in which the modem places a call.
outline fonts Characters described as a series of mathematical shapes. Can be

automatically scaled to any dimension with no loss of definition.

P
parity A method of detecting errors in data transmission. Due to higher-

quality telephone lines and higher-level error control protocols, many host
computers don’t support parity.
parity bit A check bit appended to an array of binary digits to make the sum

of all the binary digits, including the check bit, always odd or always even.
parity error Absence of the correct parity bit in a received character.
PBX Private Branch Exchange. An automatic switchboard for handling large
concentrations of telephones (usually digital extensions).
peripheral device A device, such as a video monitor, disk drive, printer, or

modem, used in conjunction with a computer. Often (but not necessarily)
physically separate from the computer and connected to it by wires, cables, or
some other form of interface.
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port The point of connection, usually a physical connector, between a

computer and a peripheral device, another computer, or a network.
protocol An agreement between computers about the form and content of the
information they exchange.
protocol negotiation The process of reaching agreement between computers

about the form and content of the data they exchange.
PSTN Public Switched Telephone Network.

pulse An abrupt and relatively short change in voltage, either positive or
negative, resulting in the conveyance of data in a circuit.

R
register A location in a computer or peripheral processor where an item of
information, such as a byte, is held and modified under program control.
remote computer A computer other than your Macintosh, but connected to it,

either directly or through your modem and telephone lines. A remote
computer can be at any distance from your computer, from right beside it to
thousands of miles away.
RJ-11 The modular phone jacks and receptacles for telephone equipment

used in the United States and Canada.
RS-232-C A physical and electrical interface between computers, terminals,

modems, and communications lines. A standard developed by the Electronics
Industries Association (see serial interface connection).
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S
serial communication Data that is transmitted one bit at a time over one wire,
as compared with parallel communication, where data is transmitted several
bits at a time over several wires.
serial interface connection A socket (or port) on the back of your computer
designed to connect with a device that receives characters one at a time or
serially.
serial modem A modem that uses a serial interface and serial

communications.
smoothing A process of converting the 200 dpi fax display to the 72 dpi of

the Macintosh display without losing resolution.
synchronous Having a constant time interval between successive bits,

characters, or events. The term implies that all the equipment in the system is
in step.
synchronous transmission A transmission process such that between any two

significant instances there is always an integral number of unit (time)
intervals.

T
telecommunications The transmission of information across long distances,

such as over telephone lines.
terminal An input/output device consisting of a typewriter-like keyboard and

a display device, used for communicating with a large computer. Personal
computers typically have all or part of a terminal built into them.
terminal emulation Software that transforms your Macintosh into a remote

terminal for any dial-up computer system.
terminal mode The communications software mode of operation in which

keyboard input is sent to the modem, which recognizes it as commands or
passes it on to the remote modem. Contrast with command state.

164

G

L O S S A R Y

throughput The effective data transfer rate measured in bps. This rate is a
combination of the connection rate and data compression. A compressed
version of a file transfers more quickly than an uncompressed version even
though the connection rate is the same.
tone-dialing A method of dialing by sending dual-tone modulated frequency
(DTMF) signals over the phone line.

V
V.32 A CCITT protocol defining the frequency and modulation used between
two high-speed modems (9600, 4800 bps).
V.32 bis A CCITT protocol defining the frequency and modulation used

between two high-speed modems (7200, 12000, 14400 bps).
V.42 A CCITT error control protocol.
V.42 bis A CCITT data compression protocol.

X
XModem A protocol devised by Ward Christianson to send files from one

computer to another that informs you if an error occurs. Also known as
MODEM7.
XON/XOFF A handshake protocol (transmit-On/transmit-Off) used by

computers and intelligent terminals to control the flow of data between the
systems.

Y
Y-connector A special connector that converts one jack into two, so that two

phone lines can be plugged into one receptacle. Also known as a Y-jack.
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A

B

accessing Fax Terminal 55
adding addresses 45
adding graphics 82, 89
addresses 6, 45–47, 53
addressing a fax 48, 57
aligning fields to a grid 86
aligning fields to each other 88
answering manually 107
AppleLink 105, 111, 151
AppleTalk Remote Access 3, 102,
105–107, 111, 149–150
archiving Fax Log 62
ASCII character set 136
asynchronous 109, 125, 129–130, 132,
148
AT command set 12, 107–108, 112–113,
115, 117
Auto Dial 44, 53
auto-answer 29, 35–36, 64, 68, 100–101,
105–107, 146
auto-reliable mode 135
automatic dialing 35, 44

backspace 61, 123
best available connection 16, 148
bitmapped 39, 92
bitmapped fonts 92
blind dialing 100–101, 124, 130
blinking arrow 65–66
blinking icon 30, 51–52, 65
break 130–131, 134
busy signal 18, 139

C
call management 29, 97–98, 105–106
call waiting 142
calling card 41–43, 119
calling card tone detect 119
Cancel Receiving command 60
Cancel Sending command 60
canceling a fax 60
CCITT 5, 84–85, 93, 96
CCL 107, 129, 149–151. See also Script.
changing the page orientation 72
changing views 50

167

checking Express Modem
installation 141
checking for received faxes 30, 65
checking the installation 138
checking the telephone line 139
Chooser 23, 37–38, 77, 149
Clear Log command 63
clearing a page 75
clearing the log 63
clipboard 74, 76, 89
command set 12, 107–108, 111–113,
115, 117, 119, 121, 123, 125,
127, 129, 131, 133, 135
command set rules 115
command state 112, 114, 116–123, 125,
130, 132
commas 42–43, 53, 118
common problems 142
communications software 3–4, 9, 12,
14–15, 19, 107, 112, 139–140,
143, 145–146, 148
Communications Toolbox 2–4, 12,
79–81, 102, 104–105
connecting 1, 8, 126, 140, 144, 148–149
connecting to older modems 144, 148
connecting your Macintosh 1, 8
connection tool 14, 104, 109, 131,
149, 151
converting a fax document to a
PICT file 77
Copy Selection command 76
copying a page 74
Cover Info dialog box 25–26, 34
cover pages 6, 9, 43, 81–82, 89, 92–95
cover page fields 82–85
credit card calls 42
crosshair 75
CTB 3, 14, 102, 104–105
customizing cover pages 43, 82
customizing fields 82
cutting a page 74
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data compression. 4–5, 12–13, 16, 108,
126, 134, 143, 148
delaying send time (“Send at”) 49
deleting faxes 61
deselecting your printer 37–38
determining the speed 13
Dial command 43, 118, 120, 124, 140
dial modifiers 43, 53
dial prefix 23, 41, 43, 48, 53
dial tone 18, 43, 53, 101, 119, 128, 130,
139–140
dithering 73
document types 56, 58
DTE–DCE 115

E
Easy Install 10
echo setting 143
ECM 36, 144
Edit menu 74–76, 84
editing a fax 74
editing addresses 46
electronic mail 3, 149
entering AT commands
from MacTerminal 113
entering cover page information 39
entering fax station information 34
error control 5, 12–13, 108, 125–127,
129, 132, 134, 148
escape sequence 112, 116–117,
121–123, 125, 132
Express Fax 1–3, 6–7, 9, 21–23, 25, 27,
29, 31, 33, 35, 37, 39, 41, 43,
45, 47, 49, 51, 53, 55, 57, 59,
61, 63, 65, 67, 105–107, 109,
111, 147
Express Fax features 6
Express Fax folder 22, 43
Express Fax messages 147

Express Fax Quick Start 9, 21, 23, 25,
27, 29, 31
Express Fax software 3, 6, 21, 105, 109
Express Fax structure 7
Express Modem control panel 10, 14–15,
19, 97–100, 104, 109, 138, 141,
146–147
Express Modem control panel status
messages 146
Express Modem disk 9, 107, 149
Express Modem features 5
Express Modem software 1, 5, 9,
105, 141
Express Modem Tool 5, 14, 16–17, 104,
109, 147
Express Modem Tool alerts 147
external modem 102, 149

F
fallback 13, 118, 121, 132
Fax Cover 6, 25, 34, 43, 53, 81, 83, 85,
87, 89, 91, 93–95, 109
fax document 34, 56–57, 67, 70–71, 77,
79
fax environment 33–34
Fax Extension 6, 109, 115
Fax Extension AT command subset 115
Fax Log 28, 55, 62–63, 65, 78
Fax menu 29, 34–36, 58, 60, 62–64,
68, 107
Fax Phone Book 9, 44–48, 51, 53, 57, 83
Fax Sender 6, 23–24, 26–27, 33–34,
37–46, 48–51, 53–54, 56–58,
79, 83, 91, 93–95, 109
Fax Sender Page Setup 38–39
Fax Sender selection shortcut 22, 38
fax station information 34
Fax Terminal 6, 27–31, 34–36, 39–40,
44, 49, 52, 54–56, 58, 60–61,
63–68, 70, 79, 107, 109,
144, 146
Fax Terminal doesn’t open 28

fax tone 52, 68
Fax Viewer 6, 31, 67, 69–79, 109
file transfer 4
first fax 28
flow control 131, 134–135
folders 35, 54, 56–57, 61, 67, 70, 78–79
Font menu 84, 95
Forward Fax command 57, 79
forwarding a fax 57, 69, 79
front-end applications 151
functional states 112

G, H, I, J, K
General communications applications 4
grabber 50
grid 86–88, 95
Group 3 fax 6, 108
handshake 131
Hardware specifications 97, 109
image files 36
image quality 39
Import PICT command 89, 95
improving fax display 69, 72
Info dialog box 25–26, 34, 39–40
Install Cover Page command 93, 95
Installer 9
installing cover pages 43, 93
installing Express Modem software
9, 141
integrated (non-serial port) modems 115
interpreting the default 116
interpreting valid parameter ranges 116
issuing AT commands 113

L, M
Layout menu 83, 86–88
local command state 112, 117,
119–120, 123
logs 63
loss of connection 142
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Macintosh Communications
Toolbox 4–5
MacTerminal 3–4, 14, 101, 105,
107, 113
Manual dial 35–36, 51–53
manual dialing 44, 51, 108
memory 28, 55, 99, 109, 117, 122, 147
memory requirements 109
menu options 95
messages 19, 25, 27, 103, 114, 122, 127,
146–147
Messages and alerts 146
MNP 13, 108, 115, 125–126, 128–130,
132, 134–135
MNP–specific AT commands 134
modem commands 111
Modem design 1, 4
modem port 8, 102, 104–105
Modem states 112
modes 109, 134
monitoring a fax 54
moving between command and
on-line 112
“My first fax” 22

N, O
normal mode 134
notification 35–36, 65
older modems, connecting to 144, 148
on-line services 4
on-line state 112, 117, 122–123, 135
Open Connection command 18
opening a fax document 56, 67
operational states 112
Options dialog box 24, 41–42, 49, 53,
56, 58
originating a call 112, 122
outline fonts 91–92
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P, Q
Page menu 71–73
page orientation 72
Page Setup options 39
parity setting 143, 145
pasting a page 74
pause 23, 42–43, 119, 124
PBX 53, 101
PICT format 69, 76–78, 89
portion of a page 75
positioning a document 71
positioning fields 85
precedence, auto-answer 101, 106
preferences 27–29, 35, 51, 55.
See also Fax Terminal
Preview command 50, 53
previewing a fax 50
previous printer settings 38
print 23, 31, 37–39, 50, 77–78, 91, 94
print preview 50
printing a fax 21, 69, 77
product codes 121
protocols 19
queue order 44, 56, 58
Quick Send 6, 21–23, 51, 57

R
reaching another modem 11, 14, 143
Received Fax Documents folder 65, 68
receiving a fax 33, 36, 64, 66
receiving manually 30, 35, 68
receiving your first fax 29
reimaging an existing fax 79
reinstalling or upgrading Express Fax 9
reliable mode 134
remote break handling 130
remote connection 4
Remove Cover Page command 94, 95
removing addresses 47
reposition a graphic 90
resequencing a fax 77

resetting the modem 142
resetting the send time 49, 56, 58
resizing fields 85
restart 10, 99, 141
result codes 116, 122, 127–130, 135
retry 36, 44, 56

S
S registers 117, 122–123
sample cover page 43, 91
Save As command 77
Save Log As command 63
screen display problems 145
script 107, 115, 129, 151
script compatibility 115
scrolling pages 50, 71
selecting a cover page 43
selecting a portion of a page 75
selecting Express Modem Tool 16
selecting Fax Sender 23, 37–38
selecting the serial port 102
selection rectangle tool 75–76
“Send at” 49, 53, 56
Send Immediately 49, 53, 56
send time 39, 45, 49, 53–56, 58–59, 91,
93
Send To field 44–45, 48
sender information 25–26, 53
sending a fax with a credit card 41
sending the same fax to more than one
recipient 44
Sent Fax Documents 56–57, 67
serial connection 115
serial port 102
Set Alignment command 87–88, 95
Set Log Entries command 62–63
setting auto-answer 101, 105–106
setting Fax Terminal preferences for
receiving 64
setting Preferences 27–29, 35, 51, 55
setting send time 49
setting the S registers 117

setting up a connection 12
setting up AppleLink 151
setting up AppleTalk Remote Access
3, 149
setting up the fax environment 34
Settings menu 16, 102, 113, 148
several recipients, sending a fax to 44
shortcut for selecting Fax Sender 22–23,
37–38
Show Fields command 83
Show Grid Lines command 86, 95
Smoothing 6, 72–73
Software specifications 97, 108
software you can purchase 3
Sound control panel 14, 102, 121, 139
speaker volume 14, 102, 121
Special commands 117, 149, 151
standard AT commands 118
Station ID 25, 34
status field 19, 66, 98, 103
status messages 19, 103, 146
Style menu 84
System Folder 9, 149

T, U
TeachText 22, 63, 77
Telephone Credit Card option 41
terminal emulation 4, 101
terminal mode 139, 142
tone detect 43, 119
Touch-Tone 53, 113, 118–119, 127
troubleshooting 137, 139, 141, 143, 145,
147, 149, 151
TrueType fonts 91–92
Turn Grid On command 86, 95
turning the modem on and off 99
unreadable characters 142–143
upgrading the Express Fax software 9
Use Smoothing command 73
using a telephone credit card 41
using AppleTalk Remote Access
149–150
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using AT commands 113, 148
using dial modifiers 43
using Fax Phone Book 45
using Fax Quick Send 21–22
using Fax Sender 33, 37
using the Fax Log 62
using the grid 86

V, W, X, Y, Z
V.17 6, 36, 108, 144
V.32 108, 133
V.32 bis 108
V.42 13, 108, 113, 125–126,
129–130, 132
V.42 bis 13, 108, 113, 126, 129
verbalize result codes 128
verifying software installation 141
viewing a fax 67, 69, 71
viewing Fax Terminal 55
waiting queue 44
Waiting To Be Sent folder 58
Windows menu 28, 55, 62
your modem package 2
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